Oracle SCM Cloud

Configuring and Managing B2B Messaging

20B
Contents

Preface i

1 Introduction 1
   Overview of Collaboration Messaging Framework 1
   How You Configure Collaboration Messaging Framework 1

2 Collaboration Messaging Framework Setup 3
   Define Message Processing and Delivery Method Parameters 3
   Set Up a Business Process 4
   Reprocess Outbound Error Messages Automatically 7

3 Collaboration Messaging Web Service 9
   Overview of Collaboration Messaging Web Services 9

4 External Message Definitions 11
   Overview of Managing External Message Definitions 11
   Create an External Message Definition 11
   Add a Message Standard Lookup Code 13

5 Collaboration Message Definitions 15
   How You Manage Collaboration Message Definitions 15
   Create a Collaboration Message Definition 15
   Duplicate a Collaboration Message 17
   Edit a Collaboration Message 17
   Delete a Collaboration Message 17
   Export the Message Transformation Package 17
   Overview of Configuring Email Properties 18
### Message Implementation

- Overview of Message Implementation
- Acknowledge Purchase Order Inbound Message
- Acknowledge Purchase Order Inbound Message Processing
- Accept a Purchase Order
- Reject a Purchase Order
- Accept a Purchase Order and Reject Some Purchase Order Lines
- Accept a Purchase Order with Changes

### Collaboration Messaging Service Providers

- Overview of Service Providers and B2B Messaging
- Create User-Defined Collaboration Messaging Service Providers
- Define Delivery Methods
- Define Outbound Collaboration Messages
- Define Inbound Collaboration Messages
- How You Configure Predefined Service Providers

### Collaboration Messaging for B2B Trading Partners

- Overview of Trading Partners
- How You Set Up Trading Partners
- Set Up a Trading Partner With a Service Provider
- Set Up a Trading Partner Without a Service Provider
- Define Delivery Methods for a Trading Partner Without a Service Provider
- Define Outbound Messages for a Trading Partner Without a Service Provider
- Define Inbound Messages for a Trading Partner Without a Service Provider
- View Associated Application Partners
- Manage Confirmation Codes
- Set Up Message Processing Rules
- Associate Trading Partners with Suppliers and Customers

### Set Up Suppliers for Procure-to-Pay

- How You Set Up Suppliers for Procure-to-Pay
- Enable the Procure-to-Pay Business Process
- Associate Suppliers with Trading Partners for Procure-to-Pay
### 10 Set Up Suppliers for Supply Chain Operations

- How You Set Up Suppliers for Supply Chain Operations
- Enable the Supply Chain Operations Business Process
- Associate Suppliers with Trading Partners for Supply Chain Operations

### 11 Set Up Customers for Order-to-Cash Invoicing

- Set Up Customers for Invoicing

### 12 Set Up Customers for Order-to-Cash Ordering and Shipping

- Overview
- Associate a Trading Partner with a Customer
- Manage B2B Location Codes

### 13 Manage B2B Configuration

- Overview of Managing B2B Configuration
- How You Manage B2B Configuration
- Header Information for Exchanging Messages

### 14 Set Up B2B Digital Certificates

- Overview of Setting Up B2B Digital Certificates
- Create Keystore Password
- Generate Certificate
- Generate Certificate Signing Request
- Import Signed Certificate from CA
- Export Certificate
- Delete Certificate
- Import Certificate
- Complete the Setup of B2B Digital Certificates

### 15 Domain-Value Maps

- Overview of Domain-Value Mapping
- How You Set Up and Use Domain-Value Maps
- Review Domain-Value Map Names in Predefined Messages
- Set Up Domain-Values Maps
- Add or Edit Domain-Value Map Data
- Specify Trading Partner Qualifier for Domain-Value Map Look Up
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>16</strong> Collaboration Messaging Setup Data Import</td>
<td>83</td>
</tr>
<tr>
<td>Overview of Importing Collaboration Messaging Setup Data</td>
<td>83</td>
</tr>
<tr>
<td>Create a Collaboration Messaging Setup Data File</td>
<td>83</td>
</tr>
<tr>
<td>Import Collaboration Messaging Setup Data</td>
<td>88</td>
</tr>
<tr>
<td>Manage Collaboration Messaging Setup Data Import</td>
<td>89</td>
</tr>
<tr>
<td>Undo Import</td>
<td>89</td>
</tr>
<tr>
<td><strong>17</strong> Validate Collaboration Messaging Setup</td>
<td>91</td>
</tr>
<tr>
<td>Validate Outbound Collaboration Messaging Setup</td>
<td>91</td>
</tr>
<tr>
<td>Validate Inbound Collaboration Messaging Setup</td>
<td>92</td>
</tr>
<tr>
<td><strong>18</strong> Collaboration Messaging History</td>
<td>95</td>
</tr>
<tr>
<td>Overview of Manage Collaboration Messaging History</td>
<td>95</td>
</tr>
<tr>
<td>How You Search for Messaging History</td>
<td>95</td>
</tr>
<tr>
<td>Actions You Can Take on Messages</td>
<td>96</td>
</tr>
<tr>
<td>Message Processing History</td>
<td>96</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons ? to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- Community: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- Training: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Introduction

Overview of Collaboration Messaging Framework

You can use Oracle Fusion Collaboration Messaging Framework to enable your Oracle Fusion applications to establish business-to-business (B2B) message exchanging capabilities with your customers or suppliers.

Using this framework, you can send and receive real-time transactional B2B messages. You can exchange messages directly with your customers or suppliers or by using an intermediary such as a B2B service provider. Collaboration Messaging Framework can receive B2B messages from trading partners or service providers through Oracle B2B, an e-commerce gateway that enables the secure and reliable exchange of business documents between an enterprise and its trading partners, or directly using SOAP web services that are available to consumers. For more information, see Collaboration Messaging Web Service.

Collaboration Messaging Framework supports transformation of a B2B document, such as a purchase order, between the Oracle Fusion applications format and a message format supported by your customers or suppliers. When you send messages to partners or receive messages from them, the framework performs the required transformation.

The configuration and setup tasks you need to perform depend on the business process that you implement B2B message exchange for and whether or not you use a service provider.

How You Configure Collaboration Messaging Framework

The first configuration task you need to perform is Manage Collaboration Messaging Configuration, which enables the business process, procure to pay, order to cash or supply chain operations, that exchange B2B messages for and define other configuration parameters specific to the B2B documents. The Global Sender ID to identify the sender of all outbound documents is also defined in this section.

A number of predefined service providers are set up in Collaboration Messaging Framework. If you use one of these predefined service providers, all documents and messages are already set up. You need to define trading partners that reference the predefined service provider using the Manage B2B Trading Partners task. Select the documents you want to exchange. After you define your trading partners and select the documents that you want to exchange, you need to associate your trading partners to the customers and suppliers that have been set up in Oracle Fusion applications. Depending on the business process you set up, this association is made using one of these tasks:

- Set up your suppliers for your procure-to-pay process in Oracle Fusion Procurement for each supplier site.
- Set up your suppliers for your procure-to-pay process in Oracle Fusion Procurement or using the Collaboration Messaging Framework task Manage Supplier B2B Configuration for each supplier site.
- Set up your customers for your order-to-cash business process and, in particular, for ordering and shipping at the customer level using the Manage Customer Collaboration Configuration task in Collaboration Messaging Framework.
- Set up your customers for your order-to-cash business process and, in particular, for invoicing, using the Manage Customer Account Collaboration Configuration task in Collaboration Messaging Framework.

The trading partners you set up are associated with the customer or supplier and the documents that are to be exchanged with each of them are selected.
You can perform other optional setup tasks based on your needs. These include mapping your values for specific data elements within Oracle Fusion applications to the values of your trading partners for the same data elements. For example, your trading partner may use "Massachusetts" while you use "MA" for the name of the state. You can set up this mapping using the Manage Collaboration Messaging Domain Value Map task. You may also require a default value to be specified for a particular field or indicate that the field must have a value in an inbound or outbound message and you do this using the Setup Messaging Processing Rules option. You can set up B2B location codes to identify ship-to and bill-to locations for inbound order-to-cash B2B messages. The codes can be used as an alternative to providing the full ship-to and bill-to addresses. If B2B location codes are set up, then when an inbound order received has codes specified for the bill-to and ship-to locations, the addresses are identified and included in the message payload.

If you don't use one of the predefined service providers, then you need to create one using the Manage Collaboration Messaging Service Providers task, define the delivery methods, and define the inbound and outbound messages that you want to exchange.

If you want to exchange B2B messages directly with your customers and suppliers, you need to create trading partners using the Manage B2B Trading Partners task, define the delivery methods for them, and define the inbound and outbound messages that you want to exchange.

Collaboration Messaging Framework provides a number of predefined message definitions. If you want to exchange a message that's not predefined, you have to go through the setup and configuration process explained next.

You have to set up external message definitions to represent the format that you receive messages from your trading partners in or the format in which you need to send messages to them. The external messages are transformed to a common format that Collaboration Messaging Framework uses to send and receive the messages to Oracle Fusion applications. You can create a collaboration message definition to map the format of the external message definition to the Oracle Fusion format (using an XSL file). You can define the mapping of an existing message definition by duplicating the message definition and modifying the associated XSL file. Use the Export Transformation Package option from the Manage Collaboration Message Definitions task to download the XSL file.

After you create your message definitions, you can include them in the inbound and outbound collaboration messages that you define for your user-defined service provider or your trading partner.

After your setup is complete, you can verify it using the Validate Inbound Collaboration Messaging Setup and Validate Outbound Collaboration Messaging Setup tasks. You can handle the daily management of your B2B message exchange, including searching for messages, reviewing the details of particular messages such as status or errors encountered using the Manage Collaboration Messaging History task.
2 Collaboration Messaging Framework Setup

Define Message Processing and Delivery Method Parameters

By default, Collaboration Messaging Framework stores all source and transformed outbound and inbound documents. This facilitates auditing the documents and reprocessing or resending them when required. So you need to configure how to process outbound messages and types of delivery methods:

1. In the Setup and Maintenance work area, go to the Manage Collaboration Messaging Configuration task.
2. In the General Setup tab’s Trading Partner Search Configuration section, select a Default Service Provider. The drop-down list displays a list of pre-defined service providers available in Collaboration Messaging. The pre-seeded service provider you select here defaults to the service provider on the Search and Select: Trading Partner ID dialog box, when you use the Manage Supplier B2B Configuration task from the Collaboration Messaging work area to Edit Supplier B2B Configuration.
3. In the Outbound Message Processing section, specify values for:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Sender ID</td>
<td>Identifies the sender of all outbound messages.</td>
</tr>
<tr>
<td>Global Sender ID Type</td>
<td>Type of identifier of the Global Sender ID, for example D-U-N-S.</td>
</tr>
<tr>
<td>Maximum attachment size</td>
<td>Determines the maximum size of embedded attachments that can be included in a message.</td>
</tr>
</tbody>
</table>

**Note:** You can set up only invoice and purchase orders to send attachments. Collaboration Messaging Framework takes into account only the size of the attachments, not the size of the message.

When Collaboration Messaging Framework doesn't send attachments because they exceed the maximum size, the buyer associated with the purchase order is notified that all attachments weren't sent.

4. In the Delivery Method Types section, specify a value for **Maximum Message Size MB** for your **Delivery Method Type**.

   Here, the maximum value specified refers to the size of the message plus the size of the attachment. Collaboration Messaging Framework doesn't process messages that exceed the maximum size for a delivery method. It logs the status as Error/Failed.

5. Click **Save and Close**.

   If you need to stop storing the source and transformed outbound and inbound documents according to your business requirements, disable the options that you do not need in the Message Storage section in the General Setup tab.
Note that if you disable the Store outbound source document check box, you can't reprocess existing messages.

Set Up a Business Process

You can enable Oracle Fusion Collaboration Messaging Framework for these business processes:

- Procure to Pay
- Supply Chain Operations
- Order to Cash
- Brazil Electronic Invoicing

The collaboration business processes are enabled by default and have collaboration documents associated with them. For the collaboration documents, you can configure additional details. For example, you can enable embedding attachments in an XML message for a purchase order outbound message.

a. In the Setup and Maintenance work area, go to the Manage Collaboration Messaging Configuration task in the Suppliers or Customers functional area, and then to the Business Process Setup tab.

b. Select a collaboration business process and an associated collaboration document and, in the Configure Collaboration Documents section, click **Configure Additional Details**.

*Note:* If you disable a business process then the application doesn't send or receive outbound and inbound messages.

Procure to Pay Documents

Collaboration Messaging Framework supports these documents for the procure to pay process:

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document</th>
<th>Configuration Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Purchase Order</td>
<td>Process PO outbound</td>
<td>PROCESS_PO_OUT</td>
<td><strong>Embed attachments in the XML message</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This parameter determines if the attachments will be embedded in the XML message. If this option isn't selected, the application ignores attachments.</td>
</tr>
<tr>
<td>Acknowledge Receipt Advice</td>
<td>Process receipt acknowledgment inbound</td>
<td>ACK_RCV_ADV_IN</td>
<td>N/A</td>
</tr>
<tr>
<td>Process Invoice</td>
<td>Process invoice inbound</td>
<td>PROCESS_INVOICE_IN</td>
<td><strong>Retrieve Supplier site from PO</strong></td>
</tr>
<tr>
<td>Document Type</td>
<td>Description</td>
<td>Document</td>
<td>Configuration Parameters</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Process Shipment</td>
<td>Process Shipment Inbound</td>
<td>PROCESS_SHIPMENT_IN</td>
<td>If this parameter is selected, and if the application partner code isn't provided in the payload, the application gets the PO# from the payload and finds the supplier site information from that.</td>
</tr>
<tr>
<td>Change Purchase Order</td>
<td>Change Purchase Order Outbound</td>
<td>CHANGE_PO_OUT</td>
<td><strong>Retrieve Supplier site from PO</strong>&lt;br&gt; If this parameter is selected, and if the application partner code isn't provided in the payload, the application gets the PO# from the payload and finds the supplier site information from that.</td>
</tr>
<tr>
<td>Cancel Purchase Order</td>
<td>Cancel Purchase Order Outbound</td>
<td>CANCEL_PO_OUT</td>
<td><strong>Embed attachments in the XML message</strong>&lt;br&gt; This parameter determines if the attachments will be embedded in the XML message. If this option isn’t selected, the application ignores attachments.</td>
</tr>
<tr>
<td>Acknowledge Change Purchase Order</td>
<td>Acknowledge Change Purchase Order Inbound</td>
<td>ACKNOWLEDGE_CHANGE_PO_IN</td>
<td>N/A</td>
</tr>
<tr>
<td>Acknowledge Purchase Order</td>
<td>Acknowledge Purchase Order Inbound</td>
<td>ACKNOWLEDGE_PO_IN</td>
<td>N/A</td>
</tr>
<tr>
<td>Acknowledge Invoice</td>
<td>Acknowledge Rejected Invoice Outbound</td>
<td>ACK_REJECTED_INVOICE_OUT</td>
<td>N/A</td>
</tr>
<tr>
<td>Process Receipt Advice</td>
<td>Process Receipt Advice Outbound</td>
<td>PROCESS_RCV_ADV_OUT</td>
<td>N/A</td>
</tr>
</tbody>
</table>
## Supply Chain Operations Documents

Collaboration Messaging Framework supports these documents for supply chain operations:

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document</th>
<th>Configuration Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Forecast</td>
<td>Process Forecast Outbound</td>
<td>PROCESS_FORECAST_OUT</td>
<td>N/A</td>
</tr>
<tr>
<td>Acknowledge Forecast</td>
<td>Acknowledge Forecast Inbound</td>
<td>ACKNOWLEDGE_FORECAST_IN</td>
<td>N/A</td>
</tr>
</tbody>
</table>

## Order to Cash Documents

Collaboration Messaging Framework supports these documents for the order to cash process:

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document</th>
<th>Configuration Parameters</th>
</tr>
</thead>
</table>
| Process Purchase Order         | Process Purchase Order Inbound     | PROCESS_PO_IN          | **Electronic order source system**<br>This parameter identifies where the purchase order originated from.  
**Document security group**<br>Purchase orders delivered to Oracle Fusion Order Management are delivered as a ZIP file that contains a number of CSV files. The document security group identifies the folder in which the ZIP file gets placed. |
| Change Purchase Order          | Change Purchase Order Inbound      | CHANGE_PO_IN           | **Electronic order source system**<br>This parameter identifies where the purchase order originated from.  
**Document security group**<br>Purchase orders delivered to Oracle Fusion Order Management are delivered as a ZIP file that contains |
### Collaborating Messaging Framework Setup

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document</th>
<th>Configuration Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Purchase</td>
<td>Cancel Purchase Order Inbound</td>
<td>CANCEL_PO_IN</td>
<td>a number of CSV files. The document security group identifies the folder in which the ZIP file gets placed.</td>
</tr>
<tr>
<td>Acknowledge Purchase Order</td>
<td>Acknowledge Purchase Order Outbound</td>
<td>ACKNOWLEDGE_PO_OUT</td>
<td>N/A</td>
</tr>
<tr>
<td>Acknowledge Change Purchase</td>
<td>Acknowledge Change Purchase Outbound</td>
<td>ACKNOWLEDGE_CHANGE_PO_OUT</td>
<td>N/A</td>
</tr>
<tr>
<td>Process Shipment</td>
<td>Process Shipment Outbound</td>
<td>PROCESS_SHIPMENT_OUT</td>
<td>N/A</td>
</tr>
<tr>
<td>Process Invoice</td>
<td>Process Invoice Outbound</td>
<td>PROCESS_INVOICE_OUT</td>
<td>Number of invoices processed concurrently. This parameter determines how many invoices are processed at the same time to be sent out.</td>
</tr>
</tbody>
</table>

**Reprocess Outbound Error Messages Automatically**

Sometimes some outbound messages aren’t processed successfully because of resource issues or temporary system unavailability. You can reprocess the messages with such outbound errors automatically. You can define the window of time during which the errors occurred to include in the automatic reprocessing and determine how often the application must attempt to reprocess the outbound messages.
You can automatically reprocess messages with the status of B2B Error or with these error subtypes:

<table>
<thead>
<tr>
<th>Error Subtype</th>
<th>Reason for Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Service Invocation Failure</td>
<td>Collaboration Messaging Framework is unable to call the application service used to retrieve the outbound message payload.</td>
</tr>
<tr>
<td>External Service Invocation Failure</td>
<td>Collaboration Messaging Framework is unable to call the trading partner or service provider’s service.</td>
</tr>
<tr>
<td>Internal Service Issue</td>
<td>Collaboration Messaging Framework is unable to call an internal processing service.</td>
</tr>
</tbody>
</table>

Here’s how you enable automatic reprocessing of outbound error messages:

1. In the Setup and Maintenance work area, use the Manage Collaboration Messaging Configuration task in the Manufacturing and Supply Chain Materials Management offering.
2. In the General Setup tab, Automatic Message Reprocessing section, select the Enable Reprocessing check box.
3. Enter a value in the Reprocessing Window in hours to specify the past window of time to include messages that encountered errors.
   
   The default value is 48 hours.
4. Enter a value in the Reprocessing Interval in minutes to define the interval at which the messages must be reprocessed.
   
   The default value is 120 minutes.
5. Click Save and Close.
3 Collaboration Messaging Web Service

Overview of Collaboration Messaging Web Services

Collaboration Messaging Framework can receive B2B messages from trading partners or service providers through Oracle B2B, or directly using SOAP web services that are available to consumers.

If B2B is used, the B2B HTTP Receiver for trading partners or service providers to post messages is exposed at the endpoint https://host/b2b/httpReceiver.

Two web services are available for messaging:

1. **CollaborationMessagingService**
   
   This service is available to consumers at the endpoint https://host/soa-infra/services/default/CmkCollaborationMessagingOAGIS10InboundComposite/CollaborationMessageService.
   
   This service requires that the payload be a CollaborationMessage (of type CollaborationMessageType), and is limited to the specific set of document sub-types supported for predefined collaboration messages. The CollaborationMessageType uses type substitution to allow different OAGIS Business Object Documents to be exchanged using a single Collaboration Message root element.

2. **CollaborationMessageV2Service**
   
   This service is available to consumers at the endpoint https://host/soa-infra/services/default/CmkCollaborationMessagingInboundServiceComposite/CollaborationMessageServiceV2.
   
   This service requires the payload to be a B2BMessage (of type B2BMessageType). The B2BMessageType Contains within it an anyType element, which allows the CollaborationMessageV2Service to accept any XML document.

In both the cases, host should be replaced with the host details of the pod where the service is intended to be exposed for consumption (for example, abcd.dev.fa.us.oraclecloud.com).

The services are secured using basic authentication. The user name and password that are provided are validated; the user must be a valid Oracle Fusion applications user. Additionally, the user must be set up with the privilege required to call the collaboration message service.

If predefined job roles are used, then the user specified in the web service invocation must inherit the ORA_CMK_TRADING_PARTNER_B2B_ADMINISTRATOR_DUTY duty role.

If user-defined job roles are used, then the role must inherit the CMK_INVOKE_INBOUND_COLLAB_DOC_SERVICE_PRIV privilege.
4 External Message Definitions

Overview of Managing External Message Definitions

An external message definition is the representation of a document type in a specific format. You can identify the format by the message type, messaging standard, the version of the messaging standard, and the document subtype. Here's an example:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message type</td>
<td>Collaboration Message</td>
</tr>
<tr>
<td>Messaging standard</td>
<td>OAGIS</td>
</tr>
<tr>
<td>Version</td>
<td>10.1</td>
</tr>
<tr>
<td>Document subtype</td>
<td>ProcessPurchaseOrder</td>
</tr>
</tbody>
</table>

Collaboration Messaging Framework provides a number of predefined external message definitions. You can also add your own external message definitions for sending or receiving messages using Collaboration Messaging Framework. That, of course, depends on what your trading partner wants to use to send or receive.

Create an External Message Definition

Here's what you can do to create an external message definition:

1. In the Collaboration Messaging Framework work area, click Manage External Message Definitions from the Tasks pane.
2. On the Manage External Message Definitions page, click Actions > Add Row and enter the required details, which are described in the next table.
3. Click Save and Close.

After you create an external message definition, you create a collaboration message definition and upload an XSL file for message transformation from the new external message definition to the collaboration document using the Manage Collaboration Message Definition task.

This table describes the fields you use to create an external message definition.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that you give to your external message definition.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Defined</td>
<td>Indicates that you created the external message definition.</td>
</tr>
<tr>
<td>Document Type</td>
<td>Standards neutral representation of a message, for example, the document created or received by Oracle Fusion applications such as Process Purchase Order.</td>
</tr>
<tr>
<td>Message Type</td>
<td>The root element of the XML payload. It is associated with a messaging standard and version.</td>
</tr>
<tr>
<td>Messaging Standard</td>
<td>List of accepted message formats. You can add your own standards.</td>
</tr>
<tr>
<td>Document Subtype</td>
<td>The type of the root element that defines the XML format of the message, for example, the root element of the payload could be Collaboration Message and the document subtype could be ProcessPurchaseOrder.</td>
</tr>
<tr>
<td>Version</td>
<td>The version of the messaging standard.</td>
</tr>
<tr>
<td>Identification XPath</td>
<td>The XPath to navigate to the document subtype specified in the XML payload.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you leave the Identification XPath field blank, when the root element is the same for more than one message, Collaboration Messaging Framework searches for the Identification XPath to find the location of the document subtype in the payload to process the message. If the XPath is blank, the message isn't processed and an error is logged.</td>
</tr>
<tr>
<td>Message Identifier XPath</td>
<td>The XPath to navigate to the sender’s message ID in the XML payload. Collaboration Messaging Framework logs the sender’s message ID, which is displayed on the Manage Collaboration Messaging History page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you leave this field blank, Collaboration Messaging Framework, doesn’t log the value of the sender’s message identifier.</td>
</tr>
<tr>
<td>Trading Partner ID XPath</td>
<td>The XPath expression that identifies the location of the Trading Partner ID in an XML payload.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For inbound messages from Oracle B2B, if you don't specify the HTTP headers SENDER_ID and SENDER_ID_TYPE you may include the Trading Partner ID in the payload as specified by this XPath and the Trading Partner ID Type as specified by the Trading Partner ID Type XPath.</td>
</tr>
<tr>
<td>Trading Partner ID Type XPath</td>
<td>The XPath expression that identifies the location of the Trading Partner ID Type in an XML payload.</td>
</tr>
</tbody>
</table>
### External Message Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note</strong>: For inbound messages from Oracle B2B, if you don’t specify the HTTP headers SENDER_ID and SENDER_ID_TYPE you may include the Trading Partner ID Type in the payload as specified by this XPath and the Trading Partner ID as specified by the Trading Partner ID XPath.</td>
</tr>
</tbody>
</table>

**Related Topics**

- How You Manage Collaboration Message Definitions

**Add a Message Standard Lookup Code**

Here’s how you add a message standard lookup code:

1. In the Setup and Maintenance work area go to the Manage Standard Lookups page and search for the Lookup Type ORA_CMK_EXT_MESSAGE_STANDARD.
2. In the ORA_CMK_EXT_MESSAGE_STANDARD: Lookup Codes section, click **Actions > New** and add your message standard.
3. Click **Save and Close**.
5 Collaboration Message Definitions

How You Manage Collaboration Message Definitions

Here's how you handle message definitions in Collaboration Messaging Framework. You need to map the format of the messages that you send to or receive from trading partners through Collaboration Messaging Framework to Oracle applications or the other way around.

The mapping depends on whether the messaging is inbound or outbound. You need to define the mapping for each direction, which isn't reversible. The message definition you create references an XSL file that contains the transformations that Collaboration Messaging Framework uses.

Collaboration Messaging Framework provides many pre-seeded message definitions. You might want to change the pre-seeded mappings to accommodate trading-partner specific variations. For doing that, you need to carry out these tasks:

1. Create a new collaboration message definition, or
2. Duplicate an existing collaboration message definition and upload a modified XSL file.
3. Export the transformation package associated with a collaboration message definition and modify the XSL file to use with the new message definition.

Create a Collaboration Message Definition

Here's how you create a collaboration message definition for your trading partner:

1. In the Collaboration Messaging Framework work area, click Manage Collaboration Message Definitions.
3. In the Create Collaboration Message Definition dialog box, enter the required details.
   - The External Message Definition can be an existing message definition or an external message definition that you created.
   - The Collaboration Document determines whether the external message type will be used for inbound or outbound messaging. For an inbound message, these XPath fields appear:
     - Application Partner Code XPath is the XPath expression that identifies the location of the Oracle Fusion application partner code in a trading partner XML payload. This is used to identify the supplier site ID for the message. If you define an application partner code XPath and provide a value for the application partner code in the payload, it's used to find the supplier site ID for the message. If you leave the Application Partner Code XPath field blank, the application retrieves your supplier site ID if you enabled Retrieve supplier site from PO for Process Invoice Inbound and Process Shipment Inbound in Setup and Maintenance > Manage Collaboration Messaging Configuration > Business Process Setup > Configuration Collaboration Documents.
     - Object Key XPath is an XPath expression that identifies the location of the object key in an XML payload. For example, invoice number is the object key in the invoice XML file. You should provide values for the Object Key XPath and for the Object Key in your payload because that information is...
logged and helps you find associated messages on the Manage Collaboration Messaging History page.

- Reference Object Key XPath is an XPath expression that identifies the location of the reference object key in an XML payload. For example, the purchase order number is the reference object key in the invoice XML file or in the shipment XML file. You should provide values for the Reference Object Key XPath and for the Reference Object Key in your payload because that information is logged and helps you find associated messages on the Manage Collaboration Messaging History page.

  o Select an XSL File for your collaboration message transformation.
  o Select a Payload Template to be used when validating an inbound or an outbound document set up.

4. Click **Save and Close**.

This table describes the fields you need to enter to create a collaboration message definition.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the collaboration message definition.</td>
</tr>
<tr>
<td>External Message Definition</td>
<td>An external message definition is a representation of a document type in a specific format, the list displayed may be either user defined or pre-seeded.</td>
</tr>
<tr>
<td>Messaging Standard</td>
<td>A unique name for a group of messages defined by an organization or entity, for example, OAG.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the standard being used.</td>
</tr>
<tr>
<td>Message Type</td>
<td>A unique XML schema definition for a document type. It’s the root element of the payload.</td>
</tr>
<tr>
<td>Message Subtype</td>
<td>A unique value to identify a message when many messages have the same root element.</td>
</tr>
<tr>
<td>Collaboration Document</td>
<td>The collaboration document to which you map the external message type. It may be inbound or outbound. A collaboration document is the Oracle Fusion definition of a business message.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the collaboration message definition.</td>
</tr>
<tr>
<td>Application Partner Code XPath</td>
<td>An XPath expression that identifies the location of the Oracle Fusion application partner code in a trading partner XML payload.</td>
</tr>
<tr>
<td>Object Key XPath</td>
<td>An XPath expression that identifies the location of the object key in an XML payload. For example, invoice number is the object key in the invoice XML file.</td>
</tr>
<tr>
<td>Reference Object Key XPath</td>
<td>An XPath expression that identifies the location of the reference object key in an XML payload. For example, purchase order number is the reference object key in the invoice inbound XML file or in the shipment inbound XML file.</td>
</tr>
<tr>
<td>XSL File</td>
<td>The file used for the transformation.</td>
</tr>
</tbody>
</table>
## Duplicate a Collaboration Message

When you want to modify a transformation for an existing message definition to use for a mapping, you can duplicate the existing collaboration message and add a modified XSL file. Here’s how you can do that:

1. In the Collaboration Messaging Framework work area, click **Manage Collaboration Message Definitions**.
2. On the Manage Collaboration Message Definitions page, search for the collaboration message definition that you want to duplicate.
3. Select the collaboration message and click **Actions > Duplicate Collaboration Message**.
4. Select an XSL File to upload.
   
   You can modify an existing XSL file and use it.
5. Select a Payload Template file to upload.
6. Click **Save and Close**.

## Edit a Collaboration Message

You can only edit collaboration messages that are user defined.

When you edit a collaboration message, you can upload a different XSL file for message transformation, and you can also modify these values:

- Description
- Application Partner Code XPath
- Object Key XPath
- Reference Object Key XPath
- Payload Template

## Delete a Collaboration Message

You can only delete user-defined collaboration messages. Here’s how:

1. On the Manage Collaboration Message Definitions page, search for and select a collaboration message definition.
2. Click **Actions > Delete Collaboration Message**.
Export the Message Transformation Package

You can export the message transformation package for an existing collaboration message definition and then you can modify the associated XSL file.

Here's what you need to do to export the message transformation package:

1. In the Collaboration Messaging Framework work area, click Manage Collaboration Message Definitions.
2. On the Manage Collaboration Message Definitions page, search for and select the collaboration message definition whose message transformation package you want to export.
3. Click Actions > Export Transformation Package.
4. Extract the contents of the compressed file that downloads.

The extracted contents are:

- An xsd folder with the source (message definition) and target (trading partner message definition) schema XSD files.
- An xsl folder that contains the .XSL transformation file, which can be imported into any XSL editor for creating a user-defined transformation.
- A payload template folder that contains an example XML file that can be modified and used for testing.

Overview of Configuring Email Properties

You can send a B2B message as an attachment to an email. You can configure some of the data attributes of the XML payload and their layout to be included in the body of the email. You then have to modify the XSL file associated with the user-defined message definition.

For a user-defined outbound message definition, you can define:

- The subject line of the email.
- An XPath from which to extract the email IDs of the recipients.
- The layout of attributes in the XML payload.

You then have to modify the XSL file associated with a message definition to extract the data attributes from the payload for the email.

Configure Email Properties

Here's how you can configure email properties for an outbound user-defined message:

1. In the collaboration Messaging Framework area, click the Manage Collaboration Message Definitions task.
2. On the Manage Collaboration Message Definitions page, select Direction as Outbound and search for an outbound user-defined message definition.
3. Select the user-defined message definition and click Actions > Configure Email Properties.
4. In the Configure Email Properties dialog box, enter these details:
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Subject Line</td>
<td>The default subject line for the email.</td>
</tr>
<tr>
<td>Recipient Email ID XPath</td>
<td>Location in the payload where the email address is listed.</td>
</tr>
<tr>
<td>Header Titles</td>
<td>Sets the order and titles of the data attributes to be included in the header area of the email.</td>
</tr>
<tr>
<td>Column Titles</td>
<td>Sets the order and column titles for the table area in the email.</td>
</tr>
</tbody>
</table>

5. Click **Save and Close**.

**Include Data Attributes from XML Payload in Email Body**

Here's how you can include data attributes from the XML payload to be included in the body of an email associated with a user-defined message definition:

1. Select the message definition for the outbound message that you configured and click **Actions > Export Transformation Package**.
2. Modify the XSL file that downloads to set the data attributes that you configured.
3. For a trading partner or service provider, set up email as a delivery method and associate the delivery method for that message definition in the outbound collaboration message.
Examples for Configuring Email Properties

Here's an example of setting up the order and header titles of the data attributes to be included in the header of an email:

![Configure Email Properties](image)

- **Collaboration Message Definition**: OAGIS_10.1_PROCESS_PO_COLLAB_MSG_OUT_30010013290326
- **Default Subject Line**: Process Purchase Order
- **Recipient Email ID XPath**: 
- **Header Titles**: PO Number, Total Amount, Order Date Display
Here's an example of setting up the order and column titles for the table area in the email:

![Configure Email Properties](image)

Here's an example of a modified XSL file:

```xml
<cmk:OutboundCollaborationMessage>
  <xsl:attribute name="xsi:type">
    <xsl:text disable-output-escaping="no">cmk:ProcessPurchaseOrderOAGIS721OutboundType</xsl:text>
  </xsl:attribute>
  <cmk:EmailContent>
    <cmk:EmailBodyHeader>
      <cmk:PropertyRow RowNumber="1">
        <cmk:PropertyRowValue>
        </cmk:PropertyRowValue>
      </cmk:PropertyRow>
      <cmk:PropertyRow RowNumber="2">
        <cmk:PropertyRowValue>
        </cmk:PropertyRowValue>
      </cmk:PropertyRow>
      <cmk:PropertyRow RowNumber="3">
        <cmk:PropertyRowValue>
        </cmk:PropertyRowValue>
      </cmk:PropertyRow>
    </cmk:EmailBodyHeader>
  </cmk:EmailContent>
</cmk:OutboundCollaborationMessage>
```
And, here's what would be the resultant email body content:

Subject: Process Purchase Order

PO Number: 1002675
Total Amount: 150.39

<table>
<thead>
<tr>
<th>PO Line Number</th>
<th>Item</th>
<th>Quantity</th>
<th>Unit</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CM13139</td>
<td>1</td>
<td>150.393</td>
<td>150.393</td>
</tr>
</tbody>
</table>
6 Message Implementation

Overview of Message Implementation

This section provides the information you need to implement an acknowledgment purchase order inbound message.

Acknowledge Purchase Order Inbound Message

Suppliers send an acknowledgment message to buyers to acknowledge receipt of a purchase order, and to communicate whether the order is accepted, rejected, or modified.

Acceptance, rejection, or modification can apply at three levels of an order:

- Header
- Line
- Line Schedule

If the acknowledgment is requesting a modification, then the following information can be included:

- Price
- Quantity
- Promised Ship Date
- Promised Delivery Date
- Backorder
- Partial Backorder

Manage Your Acknowledgment Codes

Suppliers communicate acceptance, rejection, or changes using different codes, and the codes used aren't standardized among suppliers. To process the acknowledgment, the XSL must detect these code values in the document and interpret them properly. To enable this, the XSL file contains lists of code values, documented in the table that follows. The lists in the XSL file contain commonly used codes, and you can to modify them based on the codes used by your suppliers.

<table>
<thead>
<tr>
<th>Order Level</th>
<th>Code List Name</th>
<th>Code values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>orderAccept</td>
<td>ACCEPT, AT</td>
</tr>
<tr>
<td>Header</td>
<td>orderReject</td>
<td>REJECT, RD</td>
</tr>
<tr>
<td>Header</td>
<td>orderChange</td>
<td>CHANGE, CE</td>
</tr>
</tbody>
</table>
### Define the Default Reject Reason

The default reason for rejection is provided in the XSL file (`defaultRejectReason` is Not Provided). You can use the default reason or provide your own reason by modifying the XSL file. If no reason for rejection is provided in the payload, the default reason for rejection from the XSL file is used.

### Set the Required Acknowledgment in Procurement

The Required Acknowledgment setting in the purchase order determines if lines are required in the PO Acknowledgment.

From the Required Acknowledgment drop-down list:

- Select **Document** to process only the header code acknowledgment values. This is for the simple case of accepting or rejecting the purchase order as a whole.
- Select **Document and Schedule** to accept, reject, or change the purchase order at the line level. For most B2B use cases, you will need to select **Document and Schedule**.

### Related Topics

- [Export the Message Transformation Package](#)
Acknowledge Purchase Order Inbound Message Processing

The inbound Acknowledge Purchase Order message processes acknowledgment code values provided at each level: header, line, and line schedule.

If the acknowledgment code value provided in the payload at any level (header, line, or line schedule) is invalid or not provided, then message processing is skipped. And a message is logged with a status of skipped.

Example of Header-Level Acknowledgment Code

Here’s an example:

```xml
<Status>
  <Code>REJECT</Code>
  <Reason>Rejection Reason</Reason>
</Status>
```

Note: If no reason for rejection is provided in the payload, the default reason for rejection from the XSL file is used.

Common use cases for using the Acknowledgment Purchase Order inbound process are described in later sections.

Accept a Purchase Order

To accept a purchase order as a whole, the acknowledgment code value provided at the header level in the payload must be a value that's in the `orderAccept` acknowledgment code list.

All lines must be in the payload, with acknowledgment code values that exist in the `lineAccept` acknowledgment code list.

Line schedules are required in the payload, and they must contain valid acknowledgment code values that are in the `scheduleAccept` acknowledgment code list.

Reject a Purchase Order

To reject a purchase order as a whole, the acknowledgment code value provided at the header level in the payload must be a value that's in the `orderReject` acknowledgment code list. The entire purchase order is rejected, regardless of any acknowledgment code values at the line or line schedule level.

All lines must be in the payload, but acknowledgment codes aren’t required. If provided, they’re not evaluated.

The line schedules are required in the payload, but acknowledgment codes aren’t required. If provided, they’re not evaluated.
Example of Accept or Reject at Line Level

Here's an example:

```xml
<!--ACCEPT/REJECT AT LINE LEVEL -->
<PurchaseOrderLine>
  <LineNumberID>1</LineNumberID>
  <Status>
    <Code>REJECT</Code>
    <Reason>Rejection Reason @ Line Level</Reason>
  </Status>
</PurchaseOrderSchedule>

<PurchaseOrderSchedule>
  <LineNumberID>2</LineNumberID>
  <Status>
    <Code>REJECT</Code>
    <Reason>Rejection Reason @ Schedule Level</Reason>
  </Status>
</PurchaseOrderSchedule>
</PurchaseOrderLine>
```

Note: If a reason isn't provided, then the defaultRejectReason is used.

Accept a Purchase Order and Reject Some Purchase Order Lines

To accept a purchase order with some rejected lines, the acknowledgment code value provided at the header level in the payload must be a value that's in the orderAccept acknowledgment code list.

All lines must be in the payload, and each line must have an acknowledgment code value that's in the lineAccept or lineReject acknowledgment code list.

The line schedules must be provided in the payload, and they must contain valid acknowledgment codes that are in the scheduleAccept or scheduleReject list of acknowledgment codes.

Accept a Purchase Order with Changes

To accept a purchase order with changes, the acknowledgment code value provided at the header level in the payload must be a value that's in the orderChange acknowledgment code list.

In the previous use cases for accept or reject, all lines had to be included in the acknowledgment message. In the case of change, only lines that have an acknowledgment code value in the lineChange, linePriceChange, or lineReject need to be provided in the payload. Lines that aren't provided are assumed to be accepted.
At least one line must be provided. If no lines are provided in the payload, the message is skipped. And a message is logged with a status of skipped.

In the case of change, either line or line schedule level codes, or both, may be applicable, depending on what’s being changed. Price change is communicated at the line level; whereas, quantity, date, or partial backorder changes are communicated at the line schedule level.

**Line-Level Changes**

Each line in the payload must have an acknowledgment code value in the `lineAccept`, `lineReject`, `lineChange`, or `linePriceChange` acknowledgment code lists.

The only change that you can make at the line level is a price change. In this case, the acknowledgment code value must be in either the `lineChange` or `linePriceChange` acknowledgment code lists.

Quantity must be provided at the line level if the acknowledgment code value at the line schedule level is in the `scheduleQuantityChange`, `scheduleChange`, or `schedulePartialBackOrder` acknowledgment code lists. And the total of the line schedule quantities must equal the quantity at the line level.

UOM isn’t required at the line level; however, if provided, it must match the original UOM on the purchase order line.

**Example of Line Price Change**

Here’s an example:

```xml
<!--PRICE CHANGE AT LINE LEVEL-->
<PurchaseOrderLine>
  <LineNumberID>2</LineNumberID>
  <Status>
    <Code>PRICECHANGE</Code>
    <Extension typeCode="OracleExtension">
      <Amount typeCode="Price">100.00</Amount>
    </Extension>
  </Status>
</PurchaseOrderLine>
```

The line schedules aren’t required in the payload if there is no change at that level (quantity or date). But, if they’re, they must contain acknowledgment code values.

**Line Schedule-Level Changes**

In addition to making price changes at the line level, you can also make changes at the line schedule level. At the line schedule level, you can change the quantity and date. The acknowledgment code values provided at the line schedule level must be in one of the following acknowledgment code lists:

- `scheduleQuantityChange`
- `scheduleDateChange`
- `schedulePartialBackOrder`
- `scheduleAccept`
- `scheduleReject`

UOM isn’t processed, if provided at the line schedule level.
If the line schedule has both a quantity and date change, and it isn't split, then the acknowledgment code value provided in the payload must be in the `scheduleChange` acknowledgment code list.

If the line schedule quantity changes, or the schedule is split (for example, a partial backorder), then the total of the line schedule quantities must be equal to the line quantity.

If a line schedule has only one acknowledgment code, then it must be in one of these code lists: `scheduleChange`, `scheduleQuantityChange`, `scheduleDateChange`, `scheduleReject`, or `scheduleAccept`.

If a line schedule has two acknowledgment code values in the payload, then one acknowledgment code value must be in the `schedulePartialBackOrder` list of acknowledgment codes and the other one must be in the `scheduleAccept` code list.

If a line schedule has three or more acknowledgment code values provided in the payload, then message processing is skipped. And a message is logged with a status of skipped.

**Example of Line Schedule Accept or Reject**

Here's an example:

```xml
<!-- ACCEPT/REJECT AT SCHEDULE LEVEL-->
<PurchaseOrderLine>
  <LineNumberID>3</LineNumberID>
  <Status>
    <Code>CHANGE</Code>
  </Status>
  <PurchaseOrderSchedule>
    <LineNumberID>1</LineNumberID>
    <Status>
      <Code>ACCEPT</Code>
    </Status>
  </PurchaseOrderSchedule>
  <PurchaseOrderSchedule>
    <LineNumberID>2</LineNumberID>
    <Status>
      <Code>REJECT</Code>
      <Reason>Quantity not available</Reason>
    </Status>
  </PurchaseOrderSchedule>
</PurchaseOrderLine>
```

**Note:** If a reason isn't provided, then `defaultRejectReason` is used.

**Example of Line Schedule Date and Quantity Changes**

Here's an example:

```xml
<!-- DATE & QUANTITY CHANGE AT SCHEDULE LINE LEVEL-->
<PurchaseOrderLine>
  <LineNumberID>4</LineNumberID>
  <Status>
    <Code>CHANGE</Code>
    <Extension typeCode="OracleExtension">
      <DateTime typeCode="PromisedShipDate">2019-02-14T00:00:00Z</DateTime>
    </Extension>
  </Status>
  <PurchaseOrderSchedule>
    <LineNumberID>1</LineNumberID>
    <Status>
      <Code>CHANGE</Code>
      <Extension typeCode="OracleExtension">
        <Quantity unitCode="Each" typeCode="OrderQuantity">25.0</Quantity>
      </Extension>
    </Status>
  </PurchaseOrderSchedule>
</PurchaseOrderLine>
```
<DateTime typeCode="PromisedDeliveryDate">2019-02-14T00:00:00Z</DateTime>
<Quantity typeCode="OrderQuantity">25</Quantity>
</Extension>
</Status>
</PurchaseOrderSchedule>
</PurchaseOrderLine>

**Note:**
- DateTime typeCode=PromisedShipDate is applicable if **True** is selected for Buyer Managed Transport on the order.
- DateTime typeCode=PromisedDeliveryDate is applicable if **False** is selected for Buyer Managed Transport on the order.
- The sender is expected to send one or the other, depending on whether **True** or **False** is selected on the order.

**Example of Line Schedule Date Reschedule**

Here’s an example:

```xml
<!-- DATE RESCHEDULE AT SCHEDULE LEVEL--><PurchaseOrderLine>
  <LineNumberID>5</LineNumberID>
  <Status>
    <Code>IC</Code>
  </Status>
  <PurchaseOrderSchedule>
    <LineNumberID>1</LineNumberID>
    <Status>
      <Code>RESCHEDULE</Code>
      <Extension typeCode="OracleExtension">
        <DateTime typeCode="PromisedShipDate">2019-02-14T00:00:00Z</DateTime>
        <DateTime typeCode="PromisedDeliveryDate">2019-02-14T00:00:00Z</DateTime>
      </Extension>
    </Status>
  </PurchaseOrderSchedule>
</PurchaseOrderLine>

**Note:**
- DateTime typeCode=PromisedShipDate is applicable if **True** is selected for Buyer Managed Transport on the order.
- DateTime typeCode=PromisedDeliveryDate is applicable if **False** is selected for Buyer Managed Transport on the order.
- The sender is expected to send one or the other, depending on whether **True** or **False** is selected on the order.

**Example of Line Schedule Quantity Change**

Here’s an example:

```xml
<!-- QUANTITY CHANGE AT SCHEDULE LINE LEVEL: (MUST: Sum of SCHEDULE quantities=LINE quantity)--><PurchaseOrderLine>
  <LineNumberID>6</LineNumberID>
  <Status>
    <Code>CHANGE</Code>
  </Status>
  <Extension typeCode="OracleExtension">
    <Quantity unitCode="Each" typeCode="OrderQuantity">20.0</Quantity>
  </Extension>
</PurchaseOrderLine>
```
Example of Line Schedule of Partial BackOrder

```xml
<!-- PARTIALBACKORDER AT LINE SCHEDULE LEVEL-->
<PurchaseOrderLine>
  <LineNumberID>7</LineNumberID>
  <Status>
    <Code>PARTIALBACKORDER</Code>
    <Extension typeCode="OracleExtension">
      <DateTime typeCode="PromisedShipDate">2019-02-14T00:00:00Z</DateTime>
      <DateTime typeCode="PromisedDeliveryDate">2019-02-14T00:00:00Z</DateTime>
      <Quantity typeCode="OrderQuantity">13</Quantity>
    </Extension>
  </Status>
  <Status>
    <Code>ACCEPT</Code>
    <Extension typeCode="OracleExtension">
      <DateTime typeCode="PromisedShipDate">2019-12-19T00:00:00Z</DateTime>
      <DateTime typeCode="PromisedDeliveryDate">2019-12-19T00:00:00Z</DateTime>
      <Quantity typeCode="OrderQuantity">12</Quantity>
    </Extension>
  </Status>
</PurchaseOrderSchedule>
</PurchaseOrderLine>
```

Note:
- DateTime typeCode=PromisedShipDate is applicable if **True** is selected for Buyer Managed Transport on the order.
- DateTime typeCode=PromisedDeliveryDate is applicable if **False** is selected for Buyer Managed Transport on the order.
- The sender is expected to provide one or the other, depending on whether **True** or **False** is selected on the order.
7 Collaboration Messaging Service Providers

Overview of Service Providers and B2B Messaging

A service provider is any intermediary involved in the transmission of messages between Oracle applications and your trading partner.

Oracle provides some predefined service providers for you so that you have more options for B2B messaging. You can also create your own service providers.

Create User-Defined Collaboration Messaging Service Providers

You can create and manage service providers from the Manage Collaboration Messaging Service Providers task. Here's how we do so:

1. In the Collaboration Messaging Framework work area, click Manage Collaboration Messaging Service Providers in the Tasks panel.
2. On the Manage Collaboration Messaging Service Providers page and click Actions > Create.
3. Enter the required details in the Create Collaboration Messaging Service Provider dialog box and click Save and Close.

You need to enter a unique name for the service provider. This name is used to identify the service provider for messages sent or received using the B2B adapter. Collaboration Messaging Framework uses the Provider ID and ID Type values that you enter to identify the service provider for all messages. You can set up a service provider with multiple delivery methods for outbound messages. You also need to configure outbound and inbound collaboration messages.

Define Delivery Methods

You can set up a service provider with multiple delivery methods for outbound messages.

Here's how you can do so on the Edit Collaboration Messaging Service Provider page that appears after you create a service provider.

1. Select the service provider that you created.
2. In the Delivery Methods tab, click Actions > Add Row.
3. Enter the name of the delivery method, select the delivery method type, and enter the other required details.
4. Click Save.

The required details depend on the delivery method type specified.

Note: You can't add new delivery methods or messages to predefined service providers, though you can change the URL, user name, and password of the delivery methods.
This table describes the fields used to set up a delivery method:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name, unique across trading partners, for the delivery method.</td>
</tr>
<tr>
<td>Delivery Method Type</td>
<td>List of delivery methods that Collaboration Messaging Framework supports.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select B2B Adapter as the delivery method, you need to perform additional setup steps in Setup and Maintenance &gt; Manage B2B Configuration.</td>
</tr>
<tr>
<td>Service Name</td>
<td>Predefined services required only for the Web Service delivery method type to identify the particular web service being used:</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessage.Process</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessage.ProcessAsync</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessageV2.Process</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessageV2.ProcessAsync</td>
</tr>
<tr>
<td></td>
<td>For CollaborationMessage.Process and CollaborationMessage.ProcessAsync, the payload is a collaboration message type element and the collaboration message is a type substitution element that can be used to communicate a specific set of message types that Collaboration Messaging Frameworks supports.</td>
</tr>
<tr>
<td></td>
<td>The collaborationmessageV2 service uses an any type payload, so any message type can be communicated using the V2 service.</td>
</tr>
<tr>
<td>Security Policy</td>
<td>Required only for the Web Service delivery method type.</td>
</tr>
<tr>
<td>Recipient Email ID</td>
<td>Applies to the email delivery method type. You can specify the email that receives the message payload.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can enter multiple emails separated by commas.</td>
</tr>
<tr>
<td>Attach Payload</td>
<td>This field is enabled by default when you select email as the delivery method type.</td>
</tr>
<tr>
<td></td>
<td>Attachments could be, for example:</td>
</tr>
<tr>
<td></td>
<td>• A PDF for a PO</td>
</tr>
<tr>
<td></td>
<td>• A technical drawing for a PO or Invoice</td>
</tr>
<tr>
<td></td>
<td>• The XML payload for all messages</td>
</tr>
<tr>
<td>End Point</td>
<td>Required only for the Web Service delivery method type. A Web Service endpoint is an entity, processor, or resource that can be referenced and to which Web Services messages can be addressed. It is used to identify where the trading partner service is deployed.</td>
</tr>
<tr>
<td>User Name</td>
<td>Applies to the Web Service delivery method type. It is used for basic security authentication.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Password | Applies to the Web Service delivery method type. It is used for basic security authentication.
WebCenter Content Export Account | Applies to the WebCenter Content Export delivery method. The export file is written to this account.

**Related Topics**
- Overview of Managing B2B Configuration

**Define Outbound Collaboration Messages**

You need to define outbound collaboration messages that your service provider can send to your trading partners. You have to select the collaboration message definition that corresponds to the document that the service provider will exchange for you. There could be multiple collaboration message definitions for a document. For example, you might want to define your data mapping for a predefined message using another message definition. Remember, though, that only one definition can be active at a time. And, every outbound message must have a delivery method specified.

So let's see how we define outbound collaboration messages:

1. On the Edit Collaboration Messaging Service Provider page, go to the **Outbound Collaboration Messages** tab and click **Actions > Add Row**.
2. Enter the required values for the definition and click **Save and Close**.

This table describes the fields used to define an outbound message:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the outbound message record.</td>
</tr>
<tr>
<td>Collaboration Message Definition</td>
<td>There may be multiple message definitions for a specific document, so you have to select the one you want to use. Collaboration Message Definition points to an XSL file that's used to transform the outbound message from the Oracle application message type to the external message type.</td>
</tr>
<tr>
<td>Delivery Method Name</td>
<td>The name of the delivery method for the outbound message. The drop-down list shows the delivery methods defined for the service provider.</td>
</tr>
<tr>
<td>Alternate Delivery Method</td>
<td>You can optionally specify an alternate delivery method for the outbound message. During processing, when the maximum message size for the primary delivery method is reached, Collaboration Messaging Framework processes the message using the alternate delivery method.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| **Note:** You can specify the size limitation for each delivery method type in the Setup and Maintenance work area: Manage Collaboration Messaging Configuration > General Set Up.

| Status | Valid values are:
| • Active or Inactive: You can use different collaboration messages for the same document but only one of them can be active at one time.
| • Loopback: This option enables you to process the message without actually delivering it to your trading partner so that you can test the setup.

| Retention Duration | You can specify the duration for which outbound messages must be stored before they're deleted. If retention duration is defined for a service provider, it's applicable to messages exchanged with all trading partners that are set up for that service provider.

| Retention Duration Unit | You can specify the unit of the retention duration in days, weeks, months, or years.

| External Message Type | The definition of the XML format of the message. It's always associated with a messaging standard and a version. It's the root element of the XML payload.

| Document Type | A business document created or received by Oracle Fusion applications.

| Document Sub Type | A unique value to identify a message when many have the same root element.

| Version | Version of the messaging standard used, for example OAG 10.1.

| Messaging Standard | The messaging format standard. For example cXML.

| Collaboration Object | The object for the document specified. For example, for PROCESS_ PO_OUT the collaboration object is Purchase Order.

| Collaboration Business Process | The collaboration business process for the selected document. For example, PROCESS_ PO_OUT is for the object Purchase Order and the collaboration business process procure to pay.

### Define Inbound Collaboration Messages

Unlike with outbound messages, you don't need to identify how an inbound message is received. Collaboration Messaging Framework supports web service or HTTP via the B2B Adapter for inbound collaboration messages.
So let's see how we define inbound collaboration messages:

1. On the Edit Collaboration Messaging Service Provider page, go to the **Inbound Collaboration Messages** tab and click **Actions > Add Row**.
2. Enter the required values for the definition and click **Save and Close**.

This table describes the fields you use to define an inbound message:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the inbound message.</td>
</tr>
<tr>
<td>Collaboration Message Definition</td>
<td>There may be multiple message definitions for a specific document type, so you have to select the one you want to use. Collaboration Message Definition points to an XSL file that's used to transform the external message to the Oracle application message type.</td>
</tr>
<tr>
<td>Status</td>
<td>Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Active or Inactive: You can use different collaboration messages for the same document but only one of them can be active at one time.</td>
</tr>
<tr>
<td></td>
<td>• Loopback: This option enables you to process the message without actually delivering it to your trading partner so that you can test the setup.</td>
</tr>
<tr>
<td>Application Partner Code XPath</td>
<td>Identifies the location of an element in the XML message that contains the application partner code that’s used to identify the supplier site used for processing an inbound invoice or shipment.</td>
</tr>
<tr>
<td></td>
<td>The collaboration message definition has the Application Partner Code XPath but you can change it here.</td>
</tr>
<tr>
<td>Retention Duration</td>
<td>You can specify the duration for which inbound messages must be stored before they're deleted. If retention duration is defined for a service provider, it's applicable to messages exchanged with all partners that are set up for that service provider.</td>
</tr>
<tr>
<td>Retention Duration Unit</td>
<td>You can specify the unit of the retention duration in days, weeks, months, or years.</td>
</tr>
<tr>
<td>Sender Role</td>
<td>Role of the sender of the document, customer or supplier.</td>
</tr>
<tr>
<td>External Message Type</td>
<td>The definition of the XML format of the message. It's always associated with a messaging standard and a version. It's the root element of the XML payload.</td>
</tr>
<tr>
<td>Document Type</td>
<td>A business document created or received by Oracle Fusion applications.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the messaging standard used, for example OAG 10.1.</td>
</tr>
<tr>
<td>Messaging Standard</td>
<td>The messaging format standard. For example cXML.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Collaboration Object</td>
<td>The object for the document specified. For example, for PROCESS_ PO_OUT the collaboration object is Purchase Order.</td>
</tr>
<tr>
<td>Collaboration Business Process</td>
<td>The collaboration business process for the selected document. For example, PROCESS_ INVOICE_IN is for the object Invoice and the collaboration business process procure to pay.</td>
</tr>
</tbody>
</table>

### How You View Domain Value Maps

When you exchange messages with your trading partners, you might use different values than your trading partners for the same data element. For example, you might represent the state, Massachusetts, with its full name, while your trading partner may represent it with an abbreviation, MA. This mapping of data elements from the Collaboration Messaging Framework value to the trading partner value is defined using the Manage Collaboration Messaging Domain Value Map task.

Domain value maps are assigned within the XSL file for predefined message definitions. You can see which domain values are applicable for a message definition for a particular partner or service provider on the Edit Collaboration Messaging Service Provider page for both Outbound and Inbound messages by clicking Actions > View Domain Value Maps.

**Related Topics**
- [Overview of Domain-Value Mapping](#)

### How You Configure Predefined Service Providers

Collaboration Messaging Framework has predefined some service providers for you:
- Oracle Business Network
- Oracle Supplier Network
- E2open
- Justransform
- SEFAZ

You have to perform these steps to complete configuring a service provider for your specific use. You can't add new delivery methods or create your own message definition for predefined service providers.

**Oracle Business Network**

Oracle Business Network (formerly Oracle Supplier Network) is a trading partner network available to Oracle Cloud customers.

The predefined service provider for Oracle Business Network is OracleBusinessNetwork:
Here's what you need to do to configure the predefined Oracle Business Network service provider:

1. In the Collaboration Messaging Framework work area, click the **Manage Collaboration Messaging Service Providers** task.
2. Search for **Oracle Business Network**.
3. Select the service provider row and click **Actions > Edit**.
4. On the Delivery Methods tab, there is one delivery method ORA_OracleBN_WebService of type web services. You enter the endpoint URL, user name, and password depending on your type of environment, test or production.
   - **Test**: https://osn.oracle.com/HTTPService/ProcessSOAPCollaborationMessage
   - **Production**: https://osn-prod.oracle.com/HTTPService/ProcessSOAPCollaborationMessage

   The user name and password that you enter are your Oracle Business Network's buyer account user name and password.

   The message status is set to Active in the Outbound Collaboration Messages and Inbound Collaboration Messages tabs. You can change the status if necessary.

For outbound messages, you can use these messages:

<table>
<thead>
<tr>
<th>Name of Message Definition</th>
<th>Message Standard</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_OBN_OAG_PROCESS_PO_007_OUT</td>
<td>OAGIS 7.2.1</td>
<td>Purchase Order</td>
</tr>
<tr>
<td>ORA_OBN_OAG_PROCESS_PO_006_OUT</td>
<td>OAGIS 7.2.1</td>
<td>Change Purchase Order</td>
</tr>
</tbody>
</table>

For inbound messages, you can use these messages:

<table>
<thead>
<tr>
<th>Name of Message Definition</th>
<th>Message Standard</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_OBN_OAG_PROCESS_SHIPMENT_005_IN</td>
<td>OAGIS 7.2.1</td>
<td>Shipment</td>
</tr>
<tr>
<td>ORA_OBN_PROCESS_INVOICE_002_IN</td>
<td>OAGIS 7.2.1</td>
<td>Invoice</td>
</tr>
</tbody>
</table>
Oracle Supplier Network is now known as Oracle Business Network. You may see Oracle Supplier Network as a service provider in your setup if your implementation was originally with Oracle Supplier Network.

The predefined service provider for Oracle Supplier Network is OracleSN:

<table>
<thead>
<tr>
<th>Name</th>
<th>Provider ID</th>
<th>ID Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OracleSN</td>
<td>OracleSupplierNetwork</td>
<td>Name</td>
<td>Oracle Supplier Network</td>
</tr>
</tbody>
</table>

Collaboration Messaging Framework has two delivery methods of type web services for OracleSN:

- ORA_B2BMessageProductionService (for your production environment)
- ORA_B2BMessageTestService (for your test environment)

Here's what you need to do to configure the predefined Oracle Supplier Network service provider:

1. In the Collaboration Messaging Framework work area, click the **Manage Collaboration Messaging Service Providers** task.
2. Search for **OracleSN**.
3. Select the service provider row and click **Actions > Edit**.
4. In the **Delivery Methods** tab, enter an **Endpoint URL**, and a **User Name** and **Password** for the **ORA_B2BMessageProductionService** or the **ORA_B2BMessageTestService** delivery method.

Depending on the environment (production or test) in which you configure the service provider you have to provide the endpoint URL, user name, and password for the relevant delivery method.

These are the endpoints for your production and test environments:

- Test: https://osn.oracle.com/HTTPService/ProcessSOAPCollaborationMessage
- Production: https://osn-prod.oracle.com/HTTPService/ProcessSOAPCollaborationMessage

The user name and password are the Oracle Supplier Network buyer account user name and password.

You also need to associate the delivery method to outbound messages and set the message status to Active in the Outbound Collaboration Messages tab.

For outbound messages, you can use these messages types with Oracle Supplier Network:

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 7.2.1</td>
<td>Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 7.2.1</td>
<td>Change Purchase Order</td>
</tr>
</tbody>
</table>

For inbound messages, you can use these messages types with Oracle Supplier Network:
Overview of Configuring a User-Defined Service Provider for Messaging with Oracle Supplier Network

You can configure a user-defined service provider for exchanging messages with Oracle Supplier Network if you want to exchange user-defined cXML messages, trading partner specific OAGIS 7.2.1 user definitions, or other user-defined message definitions.

If you have different user definitions for different trading partners, then you need to use multiple service providers, one for each variation. For each service provider, you create trading partners based on the corresponding supplier sites, and associate the supplier sites to the trading partners.

Note that for outbound messages, you can set up as many trading partner specific user-definitions as you want. But, you have to set up all inbound messages from all Oracle Supplier Network trading partners using the same service provider.

Any user definition done for an inbound message applies to all trading partners that are set up for that message. For example, all inbound invoices from partners can be setup as cXML messages, or all inbound shipments can be setup as OAGIS 7.2.1 messages, but you can't set up some trading partners to send cXML invoices and others to send OAGIS 7.2.1 invoices.

Configure a User-Defined Service Provider for Messaging with Oracle Supplier Network

Here's how you can create a user-defined service provider for messaging with Oracle Supplier Network:

1. In the Collaboration Messaging Framework work area, click the Manage Collaboration Messaging Service Providers task.
2. On the Manage Collaboration Messaging Service Providers page, click Actions > Create.
3. Enter the required details in the Create Collaboration Messaging Service Provider dialog box and click Save and Close.

For the service provider, add the Delivery Method type as Web Service. In the Service Name field, select the Service Name as CollaborationMessageV2.Process. Specify these details:

- **Endpoint:**
- **Test environment:** https://osn.oracle.com/HTTPService/ProcessSOAPCollaborationMessage
- **Production environment:** https://osn-prod.oracle.com/HTTPService/ProcessSOAPCollaborationMessage
- **User Name:** The Oracle Supplier Network buyer account user name
- **Password:** The Oracle Supplier Network buyer account password

Add the outbound and inbound messages you want to set up for the service provider. For outbound messages, use the Delivery Method that you created earlier. Set the status as Active for the messages. Then you can set up the trading partners you want to use with the service provider, and associate the corresponding supplier sites with these partners.
Here’s what you need to do to configure the predefined E2open service provider:

1. In the Collaboration Messaging Framework work area, click the Manage Collaboration Messaging Service Providers task.
2. Search for E2open.
3. Select the service provider row and click Actions > Edit.
4. In the Delivery Methods tab, enter an Endpoint URL, and a User Name and Password for the ORA_E2open_WebService delivery method.
   You need to obtain this information from E2open.
5. Set the outbound messages status to Active.

For outbound messages, you can use these messages types with E2open:

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Process Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Change Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Cancel Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Receipt Advice</td>
</tr>
</tbody>
</table>

For inbound messages, you can use these messages types with E2open:

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Invoice</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Shipment Notification</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Receipt Confirmation</td>
</tr>
</tbody>
</table>

Here’s what you need to do to configure the predefined Justransform service provider:

1. In the Collaboration Messaging Framework work area, click the Manage Collaboration Messaging Service Providers task.
2. Search for Justransform.
3. Select the service provider row and click Actions > Edit.
4. In the **Delivery Methods** tab, enter an **Endpoint URL**, and a **User Name** and **Password** for the **ORA_JUSTRANSFORM_WebService** delivery method.

You need to obtain this information from **Justransform**.

For outbound messages, you can use these messages types with **Justransform**:  

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Change Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Cancel Purchase Order</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Receipt Advice</td>
</tr>
</tbody>
</table>

For inbound messages, you can use these messages types with **Justransform**:  

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Invoice</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Shipment Notification</td>
</tr>
<tr>
<td>Procure To Pay</td>
<td>OAGIS 10.1</td>
<td>Receipt Confirmation</td>
</tr>
</tbody>
</table>

**SEFAZ**

The SEFAZ service provider facilitates Brazil electronic messaging. It's configured by default. But you have the option to disable the Brazil Electronic Invoicing business process.

For outbound messages, you can use these messages types with **SEFAZ**:  

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Brazil Electronic Invoice (NFe) Validation Request</td>
</tr>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Brazil Electronic Invoice (NFe) Validation Request</td>
</tr>
</tbody>
</table>
For inbound messages, you can use these messages types with SEFAZ:

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Message Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Brazil Electronic Invoice (NFe)</td>
</tr>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Brazil Electronic Freight Invoice (CTe)</td>
</tr>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Cancel Brazil Electronic Invoice (NFe)</td>
</tr>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Cancel Brazil Electronic Freight Invoice (CTe)</td>
</tr>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Brazil Electronic Invoice (NFe) Validation Response</td>
</tr>
<tr>
<td>Brazil Electronic Invoicing</td>
<td>SEFAZ</td>
<td>Brazil Electronic Invoice (CTe) Validation Response</td>
</tr>
</tbody>
</table>
Overview of Trading Partners

In collaboration messaging, you need to create a trading partner to identify different entities, such as your customer or supplier, for B2B messaging.

Before you can exchange B2B messages with a trading partner, you need to complete these high-level tasks:

1. Set up the trading partner with or without a service provider.
2. Associate the trading partner with the entity it represents; for example, a customer, customer account, or supplier site.

You can also optionally set up confirmation codes and message processing rules.

How You Set Up Trading Partners

The way you set up outbound and inbound messaging is different for trading partners that use a service provider, as an intermediary for exchanging messages, and those that don't.

If your trading partner is using a user-defined service provider (as opposed to one that's predefined for you), make sure that you have already completed setup for your service provider before associating it with a trading partner. In particular, you will need to set up the delivery methods and collaboration messages to exchange. Once those tasks are complete, all you need to do is select the service provider you want to use and the documents that you want to exchange. See the Manage Collaboration Messaging Service Providers chapter for more information.

If a service provider isn't being used, and B2B messaging is handled directly with a trading partner, then you need to define the delivery methods you want to use and the collaboration messages to exchange.

Set Up a Trading Partner With a Service Provider

If you're using a user-defined service provider as an intermediary for exchanging messages, you need to set up that service provider before proceeding with trading partner setup. If you haven't done that already, go to the Manage Collaboration Messaging Service Providers chapter and complete the tasks described before proceeding. Predefined service providers are already set up with delivery methods and collaboration messages to exchange.

Take these steps to set up a trading partner with a service provider:

1. In the Collaboration Messaging work area, click Manage B2B Trading Partners from the Tasks panel.
3. In the Service Provider field, select the service provider that the trading partner will use for B2B messaging.
4. In the Trading Partner ID field, enter an identifier for the trading partner.
5. In the Partner ID Type field, select the trading partner identification type. For example, the identification type can be the trading partner’s D-U-N-S number, name, or phone number.
6. Click **Save and Close**.

On the Edit Trading Partners page, you see a blank Outbound Collaboration Messages tab and a blank Inbound Collaboration Messages tab. By default, all message definitions for outbound and inbound messages exchanged by the trading partner are the same as the service provider’s. You can override a service provider’s message definition for any document set up for the service provider.

For trading partners that use a predefined service provider, you can set up override message definitions that use the same messaging standard that the service provider uses, for example, if you want to use a different message transformation.

For trading partners associated with a user-defined service provider, you can set up any override message definitions for your trading partner. For example, you can set up cXML message definitions for a trading partner whose user-defined service provider is set up with OAGIS 10.1 message definitions.

If you want to override the message definition of the service provider for the selected trading partner, you take these steps:

1. On the Edit Trading Partner page, click the **Outbound Collaboration Messages** or the **Inbound Collaboration Messages** tab, as required.
2. Click **Actions > Add Row**.
3. Select the message definition that you want to use instead of the message definition of the service provider.
   - If the service provider associated with the trading partner is a predefined service provider, the message definitions that are available for you to select have the same messaging standard as the service provider uses for the associated document.
   - If the associated service provider is a user defined service provider, the message definitions that are available for you to select are any that have been set up for documents that the service provider supports.
   - The delivery methods that are available for selection for the trading partner will be those of the associated service provider.
4. Add the required fields based on whether the collaboration message is outbound or inbound.
5. Click **Save and Close**.

Note: If you want to revert to using the message definition of your service provider, you have to delete the override message definition.

---

### Set Up a Trading Partner Without a Service Provider

You can set up trading partners without a service provider by specifying a service provider of **None**. Then define the delivery methods and the collaboration messages to exchange.

Take these steps:

1. In the Collaboration Messaging work area, click the Tasks panel.
2. Click **Manage B2B Trading Partners**.
3. On the Manage B2B Trading Partners page, click **Actions > Create**.
4. In the Service Provider field, select **None**.
5. In the Trading Partner ID field, enter an identifier for the trading partner.
6. In the Partner ID Type field, select the trading partner identification type.
7. Click **Save and Close**.

On the Edit Trading Partner page, next you will need to define the delivery methods and messages to exchange.
Define Delivery Methods for a Trading Partner Without a Service Provider

To set up a trading partner with delivery methods for outbound messages, take these steps:

1. In the Collaboration Messaging work area, click the Tasks panel.
2. Click Manage B2B Trading Partners.
3. On the Manage B2B Trading Partners page, in the Search section, enter or select a value in one of more of these optional fields: Service Provider, Trading Partner ID, and Partner ID Type. Then click Search.
4. Select the trading partner for which you want to define delivery methods, and click Actions > Edit. The Edit Trading Partner page is displayed.
5. On the Edit Trading Partner page, click the Delivery Methods tab.
6. Click Actions > Add Row.
7. Enter a name for the delivery method in the Name field.
8. Select the delivery method type. Depending the delivery method you selected, you might need to complete additional fields. The table that follows provides an explanation of the fields.
9. Click Save.

This table describes the fields used to set up a delivery method:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name, unique across trading partners, for the delivery method.</td>
</tr>
<tr>
<td>Delivery Method Type</td>
<td>List of delivery methods that Collaboration Messaging Framework supports.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If you select B2B Adapter as the delivery method, you need to perform additional setup steps in Setup and Maintenance &gt; Manage B2B Configuration.</td>
</tr>
<tr>
<td>Service Name</td>
<td>Predefined processes required only for the Web Service delivery method type to identify the particular web service being used:</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessage.Process</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessage.ProcessAsync</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessageV2.Process</td>
</tr>
<tr>
<td></td>
<td>• CollaborationMessageV2.ProcessAsync</td>
</tr>
<tr>
<td></td>
<td>For CollaborationMessage.Process and CollaborationMessage.ProcessAsync, the payload is a collaboration message type element and the collaboration message is a type substitution element that can be used to communicate a specific set of message types that Collaboration Messaging Frameworks supports.</td>
</tr>
<tr>
<td></td>
<td>The collaborationmessageV2 service uses an any type payload, so any message type can be communicated using the V2 service.</td>
</tr>
<tr>
<td>Security Policy</td>
<td>Required only for the Web Service delivery method type.</td>
</tr>
</tbody>
</table>
Define Outbound Messages for a Trading Partner Without a Service Provider

You need to define outbound collaboration messages that a trading partner can send to other trading partners. You have to select the collaboration message definition that corresponds to the document that want to exchange with other trading partners. There could be multiple collaboration message definitions for a document. However, only one definition can be active at a time. And every outbound message must have a delivery method specified.

Take these steps

1. On the Edit Trading Partner page, click the **Outbound Collaboration Messages** tab.
2. Click **Actions > Add Row**.
3. Enter or select values for the required fields: Name, Collaboration Message Definition, and Status.
4. Click **Save and Close**.

This table describes the fields used to define an outbound message:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Recipient Email ID                | Applies to the email delivery method type. You can specify the email that receives the message payload.  
  **Note:** You can enter multiple emails separated by commas. |
| Attach Payload                     | This field is enabled by default when you select email as the delivery method type.  
  Attachments could be, for example:  
  • A PDF for a PO  
  • A technical drawing for a PO or Invoice  
  • The XML payload for all messages |
<p>| End Point                         | Required only for the Web Service delivery method type. It is used to identify where the trading partner service is deployed. |
| User Name                         | Applies to the Web Service delivery method type. It is used for basic security authentication. |
| Password                          | Applies to the Web Service delivery method type. It is used for basic security authentication. |
| WebCenter Content Export Account  | Applies to the WebCenter Content Export delivery method. The export file is written to this account. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the outbound message record.</td>
</tr>
<tr>
<td>Collaboration Message Definition</td>
<td>There may be multiple message definitions for a specific document, so you have to select the one you want to use. Collaboration Message Definition points to an XSL file that's used to transform the outbound message from the Oracle application message type to the external message type.</td>
</tr>
<tr>
<td>Delivery Method Name</td>
<td>The name of the delivery method for the outbound message. The drop-down list shows the delivery methods defined for the service provider.</td>
</tr>
<tr>
<td>Alternate Delivery Method</td>
<td>You can optionally specify an alternate delivery method for the outbound message. During processing, when the maximum message size for the primary delivery method is reached, Collaboration Messaging Framework processes the message using the alternate delivery method. Note: You can specify the size limitation for each delivery method type in the Setup and Maintenance work area: Manage Collaboration Messaging Configuration &gt; General Set Up.</td>
</tr>
<tr>
<td>Status</td>
<td>Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Active or Inactive: You can use different collaboration messages for the same document but only one of them can be active at one time.</td>
</tr>
<tr>
<td></td>
<td>• Loopback: This option enables you to process the message without actually delivering it to your trading partner so that you can test the setup.</td>
</tr>
<tr>
<td>Retention Duration</td>
<td>You can specify the duration for which outbound messages must be stored before they're deleted. If retention duration is defined for a service provider, it's applicable to messages exchanged with all trading partners that are set up for that service provider.</td>
</tr>
<tr>
<td>Retention Duration Unit</td>
<td>You can specify the unit of the retention duration in days, weeks, months, or years.</td>
</tr>
<tr>
<td>External Message Type</td>
<td>The definition of the XML format of the message. It's always associated with a messaging standard and a version. It's the root element of the XML payload.</td>
</tr>
<tr>
<td>Document Type</td>
<td>A business document created or received by Oracle Fusion applications.</td>
</tr>
<tr>
<td>Document Sub Type</td>
<td>A unique value to identify a message when many have the same root element.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the messaging standard used, for example OAG 10.1.</td>
</tr>
<tr>
<td>Messaging Standard</td>
<td>The messaging format standard. For example cXML.</td>
</tr>
<tr>
<td>Collaboration Object</td>
<td>The object for the document specified. For example, for PROCESS_ PO_OUT the collaboration object is Purchase Order.</td>
</tr>
</tbody>
</table>
Define Inbound Messages for a Trading Partner Without a Service Provider

Unlike with outbound messages, you don’t need to identify how inbound messages are received. Collaboration Messaging Framework supports web services or HTTP by way of the B2B adapter for inbound collaboration messages.

Take these steps

1. On the Edit Trading Partner page, click the **Inbound Collaboration Messages** tab.
2. Click **Actions > Add Row**.
3. Enter or select values for the required fields: Name, Collaboration Message Definition, and Status.
4. Click **Save and Close**.

This table describes the fields you use to define an inbound message:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the inbound message.</td>
</tr>
<tr>
<td>Collaboration Message Definition</td>
<td>There may be multiple message definitions for a specific document type, so you have to select the one you want to use.</td>
</tr>
<tr>
<td></td>
<td>Collaboration Message Definition points to an XSL file that’s used to transform the external message type to the Oracle application message type.</td>
</tr>
<tr>
<td>Status</td>
<td>Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Active or Inactive: You can use different collaboration messages for the same document but only one of them can be active at one time.</td>
</tr>
<tr>
<td></td>
<td>• Loopback: This option enables you to process the message without actually delivering it to your trading partner so that you can test the setup.</td>
</tr>
<tr>
<td>Application Partner Code XPath</td>
<td>Identifies the location of an element in the XML message that contains the application partner code that’s used to identify the supplier site used for processing an inbound invoice or shipment.</td>
</tr>
<tr>
<td></td>
<td>The collaboration message definition has the Application Partner Code XPath but you can change it here.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Retention Duration | You can specify the duration for which inbound messages must be stored before they're deleted. If retention duration is defined for a service provider, it's applicable to messages exchanged with all partners that are set up for that service provider.
Retention Duration Unit | You can specify the unit of the retention duration in days, weeks, months, or years.
Sender Role | Role of the sender of the document, customer or supplier.
External Message Type | The definition of the XML format of the message. It's always associated with a messaging standard and a version. It's the root element of the XML payload.
Document Type | A business document created or received by Oracle Fusion applications.
Version | Version of the messaging standard used, for example OAG 10.1.
Messaging Standard | The messaging format standard. For example cXML.
Collaboration Object | The object for the document specified. For example, for PROCESS_PO_OUT the collaboration object is Purchase Order.
Collaboration Business Process | The collaboration business process for the selected document. For example, PROCESS_INVOICE_IN is for the object Invoice and the collaboration business process procure to pay.

**View Associated Application Partners**

The View Associated Application Partners dialog box lists of all customers, customer accounts, and supplier sites associated with the selected trading partner, as well as the documents enabled for them.

Take these steps:

1. In the Collaboration Messaging work area, click the Tasks panel.
2. Click **Manage B2B Trading Partners**.
3. On the Manage B2B Trading Partners page, in the Search section, enter or select a value in one of more of these optional fields: Service Provider, Trading Partner ID, and Partner ID Type. Then click **Search**.
4. Select the trading partner you want more information about, and click **View Associated Application Partners**. The View Associated Application Partners dialog box is displayed. You see the application partner information associated with the selected trading partner. On the View Associated Application Partners dialog box, you see the Trading Partner ID, Partner ID Type, and Service Provider. Depending on the number and type of associated application partners, you also see one or more of the following tabs: Supplier Site, Sold to Party, and Customer Account.
Supplier Site
Click the Supplier Site tab to see the supplier sites associated with the trading partner. The Supplier, Supplier Site, Supplier Number, and Application Partner code are displayed. When you select a row in the Associated Service Providers section, you see a list of collaboration documents that have already been set up for the supplier you selected.

The Application Partner Code is used only for processing inbound messages from suppliers. The code is autogenerated:

- For customers, it’s the Customer Number.
- For customer accounts, it’s the Customer Account.
- For suppliers, it’s the concatenation of the Supplier Number and the Supplier Site Name.

Sold to Party
Click the Sold to Party tab to see the Customer Name, Customer Number, and Application Partner Code associated with the trading partner. When you select a row in the Associated Service Providers section, you see a list of collaboration documents that have been set up for the customer you selected.

Customer Account
Click the Customer Account tab to see the Bill-to Customer name, Bill-to Customer Account Number, and Application Partner Code, as well as a list of collaboration documents that have already been set up for the customer account you selected.

Manage Confirmation Codes
Confirmation Codes are used to verify and confirm when a trading partner has received a B2B message. The confirmation codes that are used by trading partners might differ. You use the Manage Confirmation Codes dialog box to map the code that you receive from an invoice confirmation message to the status that your Oracle Fusion Receivables Application uses for processing. This dialog box is used only for trading partners that are receiving invoice confirmations. When an invoice confirmation message is received, the mapped codes are passed to the Oracle Fusion Receivables application.

Take these steps:

1. In the Collaboration Messaging work area, click Manage B2B Trading Partners in the Tasks panel.
2. On the Manage B2B Trading Partners page, in the Search section, enter or select a value in one of more of these optional fields: Service Provider, Trading Partner ID, and Partner ID Type. Then click Search.
3. Select the trading partner that you want to map codes from invoice confirmations, and click Manage Confirmation Codes.
4. In the Manage Confirmation Codes dialog box, click the Add Row icon.
5. In the Processing Result Code field, enter the code that the selected trading partner uses and in the Message Status field select the Oracle Fusion Receivables application status to which it maps.
6. In the Message Status field, select either Success, Error, or Other.
7. Repeat Steps 4 through 6 to add more processing result codes, until all codes map to a message status.
8. Click Save and Close.
Set Up Message Processing Rules

You can set up message processing rules for any field in an inbound or outbound partner message. You can create a rule, one per field, to either define a default value for a field or specify whether a field is required or optional. For example, you could make the Revision ID field required for a purchase order. Here's an example of the Manage Message Processing Rules dialog box, where you create the rules.

Each rule must have a unique name and node XPath (which identifies the location of the field in the message). You then either define a default value for a field or specify whether a field is required, but you can't choose both. And you can apply only one rule per field.

The XPath location is based on the external message type of the trading partner (if a service provider isn't being used) or the external message type of the service provider.

For example, if the XPath for the Revision ID field in an OAGIS 10 compliant purchase order, the XPath would be: 
ProcessPurchaseOrder/DataArea/PurchaseOrder/PurchaseOrderHeader/RevisionID

For a cXML compliant purchase order, the XPath would be: cXML/Request/OrderRequest/OrderRequestHeader/@orderVersion

Set Up Rules for a Trading Partner With a Service Provider

If your trading partner uses a service provider, and you want to set up message processing rules for one of the messages they exchange, you first need to set up a message definition for the trading partner by overriding the service provider’s message definition. See how to set up a trading partner with a service provider. Then take the steps to set up rules for a trading partner without a service provider.

Set Up Rules for a Trading Partner Without a Service Provider

If your trading partner doesn’t use a service partner, first you need to select the trading partner with which you want to exchange messages. Then select either the outbound or inbound message for which you want to set up processing rules.

Take these steps:

1. In the Collaboration Messaging work area, click Manage B2B Trading Partners from the Tasks panel.
2. On the Manage B2B Trading Partners page, in the Search section, select None in the Service Provider field. You can narrow the search further by entering values in these optional fields: Trading Partner ID and Partner ID Type. Then click Search.
3. Select the trading partner and click Actions > Edit.
4. On the Edit Trading Partner page, click either the Outbound Collaboration Messages tab or the Inbound Messages tab.
5. Select the message for which you want to set up rules, and click Actions > Manage Message Processing Rules.
6. In the Manage Message Processing Rules dialog box, you can either define a default value for a field or specify whether a field is required or optional. Do one of these:
   - To define a default value for a field, populate the Name, Node XPath, and Default Value fields.
   - To specify that a field must have a value, select the Required check box.
Collaboration Messaging for B2B Trading Partners

Note: You can either assign a default value to a field or make it required, but not both. Click the Add Rows icon for more processing rules.

7. Repeat Steps 5 and 6 until you’re finished adding processing rules.
8. Click OK.
9. Click Save and Close.

Associate Trading Partners with Suppliers and Customers

The way you associate trading partners with the entity (such as, a customer, customer account, or supplier site) it represents depends on the business process, whether the relationship is with a supplier or a customer, and the business documents you want to exchange.

When you’re defining the association between trading partners and suppliers:

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Where You Set It Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procure to pay</td>
<td>In the Procurement work area, click Suppliers. You can also associate trading partners and suppliers using the Manage Supplier B2B Configuration task in the Collaboration Messaging work area.</td>
</tr>
<tr>
<td>Supply chain operations</td>
<td>In the Collaboration Messaging work area, click Manage Supplier B2B Configuration in the Tasks panel.</td>
</tr>
</tbody>
</table>

When you’re defining the association between trading partners and customers:

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Where You Set It Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order to cash, ordering and shipping at the customer level</td>
<td>In the Collaboration Messaging work area, click Manage Customer Collaboration Configuration in the Tasks panel.</td>
</tr>
<tr>
<td>Order to cash, invoicing at the customer account level</td>
<td>In the Collaboration Messaging work area, click Manage Customer Account Collaboration Configuration in the Tasks panel.</td>
</tr>
</tbody>
</table>
9 Set Up Suppliers for Procure-to-Pay

How You Set Up Suppliers for Procure-to-Pay

To set up suppliers for the procure-to-pay business process, you need to complete these high-level tasks:

1. Enable the procure-to-pay business process.
2. Associate your suppliers with one or more trading partners, and enable the documents that you want to exchange with them.

Enable the Procure-to-Pay Business Process

Here’s how you enable the procure-to-pay business process:

1. In the Setup and Maintenance work area, use the Manage Collaboration Messaging Configuration task:
   - Offering: Procurement
   - Functional Area: Suppliers
   - Task: Manage Collaboration Messaging Configuration
3. In the Collaboration Business Process section, select the Enabled check box for the procure-to-pay business process, with the supplier trading partner role.

Associate Suppliers with Trading Partners for Procure-to-Pay

You can define the association between suppliers and trading partners for the procure-to-pay business process in two areas:

- Use the Manage Supplier B2B Configuration task in the Collaboration Messaging work area. See the section on Set Up Suppliers for Supply Chain Operations for details.
- Oracle Fusion Procurement.

Take these steps for associating suppliers and trading partners for the procure-to-pay process in Procurement.

1. In the Procurement work area, click Suppliers.
2. Click the Search icon in the panel tab and search for a supplier. The Manage Suppliers page is displayed.
3. On the Manage Suppliers page, select a supplier from the Search Results section to get details about the supplier you selected.
4. Click Actions > Edit. The Edit Supplier page is displayed.
5. Click the Sites tab.
6. On the Edit Supplier page, click Actions > Edit.
7. On the Edit Site page, scroll down and click the General tab, if it’s not already selected.
8. In the B2B Communication Method field, select **Collaboration Messaging Framework**. The Associated Collaboration Documents section is displayed. In this section, you see all the associated service providers or trading partners and the documents set up for each of them. You also see the association status, and whether it's active or not.

9. Click the **Edit** button in the Associated Collaboration Documents section.

The Edit Supplier Collaboration Configuration page is displayed, with the supplier information displayed at the top of the page and two tabs, Trading Partner Assignment and Document Setup. First, you use the Trading Partner Assignment tab, to set up the trading partners that your supplier will exchange B2B messages with and then you use the Document Setup tab to define the documents exchanged with each trading partner.

10. On the Trading Partner Assignment tab, select **Actions** to add a row. Use the drop-down list on the site field to search for and select a Site and Procurement Business Unit.

11. Use the search option available from the Trading Partner ID field to search for and select a trading partner. On the search dialog the following fields are populated:

   - The Service Provider will default to the Default Service Provider defined in Manage Collaboration Messaging Configuration.
   - The Trading Partner ID and ID Type will be populated based on the selected Supplier.
   - Additional fields of Trading Partner OBN ID and Trading Partner Name will be displayed for searching when the selected service provider is Oracle Business Network.
   - If a trading partner is selected from the Oracle Business Network search results, a connection request will be made to Oracle Business Network for that trading partner and the trading partner will be added to Collaboration Messaging if it doesn't already exist.

12. Click **Save** and then define the list of documents that you want to exchange with your trading partners in the Document Setup tab.

Here's more information on the fields in the Trading Partner Assignment tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>The supplier site to which the trading partner is being associated with. The site and Procurement BU are selected together from the search option on the Site field.</td>
</tr>
<tr>
<td>Procurement BU</td>
<td>The Procurement Business Unit to which the trading partner is being associated with. The site and Procurement BU are selected together from the search option on the Site field.</td>
</tr>
<tr>
<td>Trading Partner ID</td>
<td>The trading partner identifier.</td>
</tr>
<tr>
<td>Partner ID Type</td>
<td>The type of ID for the trading partner; for example, Name, Tax ID, D-U-N-S.</td>
</tr>
<tr>
<td>Service Provider</td>
<td>The service provider that's used by the trading partner, this is populated after the user selects a trading partner.</td>
</tr>
<tr>
<td>Trading Partner OBN ID</td>
<td>The Oracle Business Network ID of the trading partner. This is the identifier on the trading partner on the Oracle Business Network.</td>
</tr>
<tr>
<td>Sender Party ID</td>
<td>Sender ID identifies the trading partner sending the outbound message. This field allows the user to specify a sender party ID that will override the global ID defined during setup in the Setup and Maintenance work area.</td>
</tr>
</tbody>
</table>
**Chapter 9**

**Set Up Suppliers for Procure-to-Pay**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender ID Type</td>
<td>The type of ID for the sender; for example, Name, Tax ID, D-U-N-S.</td>
</tr>
<tr>
<td>Application Partner Code</td>
<td>An auto-generated code created from the concatenation of the supplier number and the site name by default. You can change this code.</td>
</tr>
<tr>
<td>Domain Value Map</td>
<td>The trading partner qualifier used when setting up the domain values for the selected trading partner. It's used to identify the domain values for the trading partners. See Manage Domain Values Map for more information.</td>
</tr>
<tr>
<td>Association Status</td>
<td>The date and time that the row was added.</td>
</tr>
</tbody>
</table>

13. Use the Document Setup tab to define the documents that you want to exchange with your trading partners for the selected Site and Procurement BU.

- The document setup tab has two sections. In the upper table you define the documents that you want to exchange with your trading partners. Any trading partners listed in this table are the primary recipient of the selected document. The list of trading partners displayed in the upper table are those trading partners that have been defined on the Trading Partner Assignment tab and also are configured to exchange the selected document.
- If there's more than one recipient for a document, select the row for that document in the upper table and then in lower table, add a row and select the trading partner that's the additional recipient of the document.

14. Click **Save**.

Here is some information on fields on this tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override Configured</td>
<td>A check in this field indicates that the trading partner for the selected document is using a different message definition than the one the associated service provider is using for that document, for example, the trading partner has overridden the service provider's message definition.</td>
</tr>
<tr>
<td>Additional Recipients</td>
<td>A check in this field indicates that there are additional recipients for the document. If there is a check in this field for any of the documents, you can select that row and view the additional recipients in the Additional Recipients section.</td>
</tr>
</tbody>
</table>
10 Set Up Suppliers for Supply Chain Operations

How You Set Up Suppliers for Supply Chain Operations

To set up suppliers for supply chain operations, you need to complete these high-level tasks:

1. Enable the supply chain operations business process.
2. Associate your suppliers with one or more trading partners, and enable the supply chain operations documents that you want to exchange with the supplier.

Enable the Supply Chain Operations Business Process

Here's how you enable the supply chain operations business process:

1. In the Setup and Maintenance work area, go to the Manage Collaboration Messaging Configuration task:
3. In the Collaboration Business Process section, select the Enabled check box for the supply chain operations business process, with the supplier trading partner role.

Associate Suppliers with Trading Partners for Supply Chain Operations

You associate your suppliers with trading partners for the supply chain operations business process (sending forecasts out and acknowledging forecast commits), or the procure-to-pay business process in the Collaboration Messaging work area.

Take these steps:

1. In the Collaboration Messaging work area, click Manage Supplier B2B Configuration from the Tasks panel.

   On the Manage Supplier B2B Collaboration page you can search for suppliers by supplier name, or supplier number and optionally by D-U-N-S. The list of suppliers comes from the Oracle Fusion Procurement application.

   Note: If there's a check mark in Collaboration Configured field, there's at least one collaboration document already set up for the supplier.

2. Select the supplier you want to associate with a trading partner, and click Edit Collaboration Configuration. The Edit Supplier Collaboration Configuration page is displayed, with the supplier information displayed at the top of the page and two tabs, Trading Partner Assignment and Document Setup.
First, you use the Trading Partner Assignment tab, to set up the trading partners that your supplier will exchange B2B messages with and then you use the Document Setup tab to define the documents exchanged with each trading partner.

3. On the Trading Partner Assignment tab, select Actions to add a row. Use the drop-down list of the site field to search for and select a Site and Procurement Business Unit.

4. Use the search option available from the Trading Partner ID field to search for and select a trading partner. On the search dialog box, the following fields are populated.
   - The Service Provider will default to the Default Service Provider defined in Manage Collaboration Messaging Configuration.
   - The Trading Partner ID and ID Type will be populated based on the selected Supplier.
   - Additional fields of Trading Partner OBN ID and Trading Partner Name will be displayed for searching when the selected service provider is Oracle Business Network.
   - If a trading partner is selected from the Oracle Business Network search results, a connection request will be made to Oracle Business Network for that trading partner and the trading partner will be added to Collaboration Messaging if it doesn't already exist.

5. Click Save and then define the list of documents that you want to exchange with your trading partners in the Document Setup tab.

Here's more information on the fields in the Trading Partner Assignment tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>The supplier site to which the trading partner is being associated with. The site and Procurement BU are selected together from the search option on the Site field.</td>
</tr>
<tr>
<td>Procurement BU</td>
<td>The Procurement Business Unit to which the trading partner is being associated with. The site and Procurement BU are selected together from the search option on the Site field.</td>
</tr>
<tr>
<td>Trading Partner ID</td>
<td>The trading partner identifier.</td>
</tr>
<tr>
<td>Partner ID Type</td>
<td>The type of ID for the trading partner; for example, Name, Tax ID, D-U-N-S.</td>
</tr>
<tr>
<td>Service Provider</td>
<td>The service provider that’s used by the trading partner, this is populated after the user selects a trading partner.</td>
</tr>
<tr>
<td>Trading Partner OBN ID</td>
<td>The Oracle Business Network ID of the trading partner. This is the identifier on the trading partner on the Oracle Business Network.</td>
</tr>
<tr>
<td>Sender Party ID</td>
<td>Sender ID identifies the trading partner sending the outbound message. This field allows the user to specify a sender party ID that will override the global ID defined during setup in the Setup and Maintenance work area.</td>
</tr>
<tr>
<td>Sender ID Type</td>
<td>The type of ID for the sender; for example, Name, Tax ID, D-U-N-S.</td>
</tr>
<tr>
<td>Application Partner Code</td>
<td>An auto-generated code created from the concatenation of the supplier number and the site name by default. You can change this code.</td>
</tr>
</tbody>
</table>
6. Use the Document Setup tab to define the documents that you want to exchange with your trading partners for the selected Site and Procurement BU.

   - The document setup tab has two sections. In the upper table you define the documents that you want to exchange with your trading partners. Any trading partners listed in this table are the primary recipient of the selected document. The list of trading partners displayed in the upper table are those trading partners that have been defined on the Trading Partner Assignment tab and also are configured to exchange the selected document.
   - If there is more than one recipient for a document, select the row for that document in the upper table and then in lower table, add a row and select the trading partner that's the additional recipient of the document.

7. Click Save.

Here is some information on fields on this tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Value Map</td>
<td>The trading partner qualifier used when setting up the domain values for the selected trading partner. It's used to identify the domain values for the trading partners. See Manage Domain Values Map for more information.</td>
</tr>
<tr>
<td>Association Status</td>
<td>The date and time that the row was added.</td>
</tr>
<tr>
<td>Override Configured</td>
<td>A check in this field indicates that the trading partner for the selected document is using a different message definition than the one the associated service provider is using for that document, for example, the trading partner has overridden the service provider's message definition.</td>
</tr>
<tr>
<td>Additional Recipients</td>
<td>A check in this field indicates that there are additional recipients for the document. If there is a check in this field for any of the documents, you can select that row and view the additional recipients in the Additional Recipients section.</td>
</tr>
</tbody>
</table>
11 Set Up Customers for Order-to-Cash Invoicing

Set Up Customers for Invoicing

You associate customers with trading partners for the order-to-cash business process, and in particular invoicing, on the Manage Account Collaboration Configuration page.

Take these steps:

1. In the Collaboration Messaging work area, click **Manage Customer Account Collaboration Configuration** in the Tasks panel.
2. On the Manage Customer Account Collaboration Configuration page, in the Search section, select Order to Cash in the Collaboration Business Process field. This is a required field.
3. Enter a value in one or more of the remaining search fields, to narrow the search results for the customer you want to associate with a trading partner, and click **Search**.
4. Select the customer you want to associate with a trading partner and click **Edit Collaboration Configuration**.
   The Edit Customer Account Collaboration Configuration page is displayed.
5. In the Associated Service Providers section, select **Actions > Add Row**.
   - In the Service Provider field, select a service provider or select **None** if you aren't using one. This is a required field, so you must select **None** if you're not going to use one.
   - In the Trading Partner ID field, select the trading partner that you want to associate with the customer.
   - In the Application Partner Code field, you can accept the default value or enter a new one.
6. In the Collaboration Documents section, select **Actions > Add Row**.
7. In the Document field, select the collaboration documents that you want to exchange with the customer. The list of documents that's displayed depends on the order-to-cash documents (in this case, process invoice outbound) that have already been set up for the service provider and or trading partner. This is a required field.
8. In the Association Status field, select **Enabled**.
9. Click **Save and Close**.

Here's some more information about the fields in the Associated Service Providers section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Provider</td>
<td>This is a required field, so you need to select <strong>None</strong> if you're not going to use one.</td>
</tr>
<tr>
<td>Trading Partner ID</td>
<td>A list of the trading partners associated with the selected service provider.</td>
</tr>
<tr>
<td>Partner ID Type</td>
<td>The type of ID for a partner is displayed; for example, name, tax ID, D-U-N-S.</td>
</tr>
<tr>
<td>Sender Party ID</td>
<td>Sender ID identifies the trading partner sending the outbound message. This field allows the user to specify a sender party ID that will override the global ID defined during setup in the Setup and Maintenance work area.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sender ID Type</td>
<td>The type of ID for the sender; for example, name, tax ID, D-U-N-S.</td>
</tr>
<tr>
<td>Application Partner Code</td>
<td>An autogenerated code created from the concatenation of the supplier number and the site name by default. You can change this code.</td>
</tr>
<tr>
<td>Domain Value Map</td>
<td>The trading partner qualifier used when setting up the domain values for the selected trading partner. It’s used to identify the domain values for the trading partners. See Manage Domain Values Map for more information.</td>
</tr>
<tr>
<td>Status Date</td>
<td>The date and time that the row was added.</td>
</tr>
</tbody>
</table>

Here’s some more information about the fields in the Collaboration Documents for Service Provider section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>A collaboration document is a business message. The documents that are displayed when a user adds a record are those documents that are defined for the service provider and trading partner or trading partner without a service provider for the procure-to-pay business process.</td>
</tr>
<tr>
<td>Sender Role</td>
<td>The role of the trading partner that’s sending the document; for example, a supplier.</td>
</tr>
<tr>
<td>Direction</td>
<td>The direction of the document, inbound or outbound.</td>
</tr>
<tr>
<td>Association Status</td>
<td>The status of the associated document for the site and trading partner. The status must be set to Enabled for the document to be processed. Some sites might be ready to exchange documents before others, and so you might want them set to Disabled until they’re ready to exchange documents. You can enable the exchange of documents at different levels: globally (at the service provider level), at the trading partner level, and at the site level.</td>
</tr>
<tr>
<td>Association Status Date</td>
<td>The date on which the association status changed.</td>
</tr>
<tr>
<td>Primary Recipient</td>
<td>When selected, the trading partner receives the document first. If the document fails to be sent to the primary recipient, it won’t be sent to any of the other recipients. For example, if an organization uses a third party to process their invoices, in that case in addition to sending the PO to their supplier, the organization also needs to send a copy to the third party that will process their invoices. This field is only available for outbound messages.</td>
</tr>
<tr>
<td>Collaboration Object</td>
<td>The object associated with the document; for example, for PROCESS_PO_OUT the collaboration object is Purchase Order.</td>
</tr>
<tr>
<td>Collaboration Business Process</td>
<td>The type of business process for the selected collaboration document; for example, the procure-to-pay business process.</td>
</tr>
</tbody>
</table>
12 Set Up Customers for Order-to-Cash Ordering and Shipping

Overview

Once you have created trading partners in Collaboration Messaging Framework, you need to associate the trading partners with either the customers or suppliers that the trading partner represents. You define the association between your trading partners and customers for your order-to-cash business process, in particular for ordering and shipping, using the Manage Customer Collaboration Configuration task.

Associate a Trading Partner with a Customer

Here’s how you associate a trading partner with a customer:

1. In the Collaboration Messaging Framework work area, click the Manage Customer Collaboration Configuration task.
2. Select Order to Cash as the Collaboration Business Process, enter a Customer Name or a Customer Number, and search for your customer.

This table describes the results of the search:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>Name of the customer.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>Numbered identifier of the customer.</td>
</tr>
<tr>
<td>Ship to Party</td>
<td>If this field is enabled, the shipment document PROCESS_SHIPMENT_OUT is configured in Collaboration Messaging Framework for the customer.</td>
</tr>
<tr>
<td>Collaboration Configured</td>
<td>If this field is enabled, there's at least one collaboration document set up for the customer.</td>
</tr>
</tbody>
</table>

3. Select the row for the customer you want to associate with a trading partner and click the Edit Collaboration Configuration tab.
5. Enter the values for the required fields and specify these:
   - Service Provider: If the trading partner you’re associating the customer with uses a service provider, select the service provider, otherwise select None.
   - Partner ID: The trading partners associated with the selected provider (if you selected one).
Partner ID type: For example, D-U-N-S or data universal numbering system.

Sender Party ID: Identifies the trading partner who sends the outbound message. You can specify a sender party ID that overrides the global sender ID defined during set up.

Application Partner Code: The code used to uniquely identify partner sites on inbound messages. It defaults to the customer number but you can edit it.

Domain Value Map: The trading partner qualifier used to identify the domain values for the customer.

Order Processing Business Unit: The business unit that processes the order received from the customer. If you don't specify an order processing business unit, the order will fail during processing.

6. In the Collaboration Documents for Service Provider section, click **Actions > Add Row**. In this section, you set up the documents that you want to exchange with the service providers and trading partners.

7. Enter the values for the required fields and specify these:

   - **Document**: The document that you want to exchange. The list of documents displayed is filtered to show the ordering and shipping documents from the list of Order to Cash documents set up for the selected service provider and trading partner.
   - **Association Status**: The status of the associated document for the site and trading partner. You must set the status to **Enabled** for the document to be processed.
   - **Primary Recipient**: Determines which trading partner receives the document first if it's being sent to more than one party.

   **Note**: If the delivery of the document to the primary recipient fails, the document isn't sent to any other trading partners listed for that document.

8. Click **Save and Close**.

### Manage B2B Location Codes

You can set up B2B location codes to identify ship-to and bill-to locations for inbound order-to-cash B2B messages. You can use the codes as an alternative to providing the full ship-to and bill-to addresses. After you set up B2B location codes, then when an inbound order includes codes specified for the bill-to and ship-to locations, Collaboration Messaging Framework retrieves the addresses and includes them in the payload.

### Add a B2B Location Code

Here's how you can add a B2B location code:

1. In the Collaboration Messaging Framework work area, click **Manage Customer Collaboration Configuration** in the Tasks panel.
2. Select **Order to Cash** as the **Collaboration Business Process**, enter a **Customer Name** or a **Customer Number**, and search for your customer.
3. Select the row for the customer you want to associate with a trading partner and click **Manage B2B Location Codes**.
4. On the Manage B2B Location Codes page, click **Add Locations**.
   
   The page displays customer sites that don't already have a location code associated with them.
5. Select the site you want and click **Add**.
6. **Click Save and Close**.
Edit a B2B Location Code
To edit a B2B location code for a customer site, click **Manage B2B Location Codes**, delete the row for your customer site, and add it again with a new B2B Location Code value.

Import B2B Location Codes
As an alternative to adding B2B location codes using the Manage B2B Location Codes tab, you can also import B2B locations using a CSV file.

The CSV file must have three columns of data with these column headers specified:

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomerNumber</td>
<td>Identifies the customer number</td>
</tr>
<tr>
<td>PartySiteNumber</td>
<td>Identifies the customer site number</td>
</tr>
<tr>
<td>LocationCode</td>
<td>Identifies the B2B location code</td>
</tr>
</tbody>
</table>

Collaboration Messaging Framework identifies the columns regardless of the order in which you enter them.

Here’s how you upload the CSV file to import B2B locations:

1. In the Collaboration Messaging Framework work area, click the **Manage Customer Collaboration Configuration** task.
2. Click **Import B2B Location Codes**.
3. Browse and select the CSV file, and click **OK**.
   - A message displays the scheduled process identifier, which you can use to review the status of the import process from Scheduled Processes.
4. On the Manage Customer Collaboration Configuration page, click **Done**.

**Note:** You can submit the process for importing B2B location codes only by using the Manage Customer Collaboration Configuration task > Import B2B Location Codes.

XPath to Include B2B Location Codes Payload
The list of XPath to identify where to include the B2B location codes in the payload so that the ship-to and bill-to addresses can be retrieved and included in the payload are:

<table>
<thead>
<tr>
<th>Document</th>
<th>Header or Line Level on Order</th>
<th>Ship-To or Bill-To Code</th>
<th>XPath of Inbound Message</th>
<th>XPath of Transformed Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>Header or Line Level on Order</td>
<td>Ship-To or Bill-To Code</td>
<td>XPath of Inbound Message</td>
<td>XPath of Transformed Message</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------</td>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PROCESS_PO_IN</td>
<td>Header level</td>
<td>Bill-to</td>
<td>CollaborationMessage/ BusinessObjectDocument/ DataArea/ PurchaseOrder/ PurchaseOrderHeader/ PurchaseOrderLine/ Location/ IDSet/ID[@typeCode=&quot;PartySiteId&quot;]</td>
<td>/ Request/ InboundCollaborationDocument/ DOOORDERS/ DOO_ORDER/ DooOrderHeadersAllInt/ DooOrderAddressesInt/ PartySiteId</td>
</tr>
<tr>
<td>PROCESS_PO_IN</td>
<td>Line level</td>
<td>Ship-to</td>
<td>CollaborationMessage/ BusinessObjectDocument/ DataArea/ PurchaseOrder/ PurchaseOrderLine/ Location/ IDSet/ID[@typeCode=&quot;AccountSiteUseId&quot;]</td>
<td>/ Request/ InboundCollaborationDocument/ DOOORDERS/ DOO_ORDER/ DooOrderLinesAllInt/ DooOrderAddressesInt/ PartySiteId</td>
</tr>
<tr>
<td>PROCESS_PO_IN</td>
<td>Line level</td>
<td>Bill-to</td>
<td>CollaborationMessage/ BusinessObjectDocument/ DataArea/ PurchaseOrder/ PurchaseOrderLine/ Location/ IDSet/ID[@typeCode=&quot;AccountSiteUseId&quot;]</td>
<td>/ Request/ InboundCollaborationDocument/ DOOORDERS/ DOO_ORDER/ DooOrderLinesAllInt/ DooOrderAddressesInt/ PartySiteId</td>
</tr>
<tr>
<td>Document</td>
<td>Header or Line Level on Order</td>
<td>Ship-To or Bill-To Code</td>
<td>XPath of Inbound Message</td>
<td>XPath of Transformed Message</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------</td>
<td>-------------------------</td>
<td>--------------------------</td>
<td>-----------------------------</td>
</tr>
</tbody>
</table>

- **Document**: The column headers include the types of information that need to be configured for customers in the context of order-to-cash ordering and shipping. These headers are designed to help users set up customers effectively within the Oracle SCM Cloud environment.

- **Header or Line Level on Order**: This column is intended to specify the level of detail at which data should be configured or processed.

- **Ship-To or Bill-To Code**: This field is likely to represent the recipient details for orders or billing information for customers.

- **XPath of Inbound Message**: This column provides the XML Path Language (XPath) paths for the inbound messages, which are crucial for understanding where data is located within the message structure.

- **XPath of Transformed Message**: This column includes XPath paths for the transformed messages, indicating how the data might be altered or manipulated during the process.

The table format serves as a structured guide for configuring and managing B2B messaging within the Oracle SCM Cloud framework, ensuring that users can efficiently set up their customers for seamless order-to-cash processes.
13 Manage B2B Configuration

Overview of Managing B2B Configuration


You need to create trading partners and trading partner agreements in Oracle B2B, for every trading partner that doesn't use a service provider and for each service provider with whom you want to exchange messages. You also have to configure the delivery channel to be used to deliver messages.

The Trading Partners that need to be set up in B2B Configuration correlate to the trading partners and service providers in Collaboration Messaging Framework:

- If a service provider is being used, then the trading partner name set up in B2B configuration needs to be the same as the service provider name in Manage Collaboration Messaging Service Providers.
- If no service provider is used, the trading partner name set up in Manage B2B Configuration has to be the same as the name of the trading partner in Manage B2B Trading Partners (which is to say, the trading partner in Manage B2B Trading Partners must be set up with an ID type of Name).

For outbound messages, all delivery related information such as URL, user name, and password are set up in Oracle B2B. You have to define the Sender ID and Sender ID type using the Manage Collaboration Configuration task so that they're included as HTTP headers.

If you use predefined collaboration message definitions for exchanging messages with trading partners or service providers, there is no need to create any new document-related artifacts in Oracle B2B. You can use predefined document definitions to create trading partner agreements. However, if you create a new external message definition in Collaboration Messaging Framework, you need to create a new document type in Oracle B2B. The document type must match the message type of the external message definition.

Your B2B setup and the corresponding setup in Collaboration Messaging Framework must have this correlation:

<table>
<thead>
<tr>
<th>B2B Artifact</th>
<th>Collaboration Messaging Artifact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Protocol</td>
<td>External Message Definition-Messaging Standard</td>
</tr>
<tr>
<td>Document Type</td>
<td>External Message Definition-Message Type</td>
</tr>
<tr>
<td>Trading Partner Name</td>
<td>• Trading Partner - ID (of type Name)</td>
</tr>
<tr>
<td></td>
<td>• Service Provider - Name</td>
</tr>
</tbody>
</table>

Note: If the trading partner uses a service provider, then the trading partner set up in B2B Configuration has to have the same name as the service provider. If there is no service provider being used, then the trading partner
Within Collaboration Messaging Framework, the setup for exchanging messages through Oracle B2B requires that the delivery method type B2B Adapter is used for the service provider or the trading partner if no service provider is being used, and the delivery method name that has B2B Adapter as the delivery method type must be associated with all inbound and outbound messages.


### How You Manage B2B Configuration

To manage B2B configuration for exchanging messages with Collaboration Messaging Framework, you need to set up:

- Trading partners
- Documents to be exchanged through Oracle B2B (only documents for user-defined external message definitions)
- Delivery channels
- Trading partner agreements

### Set Up Trading Partners

Let’s look at how you set up trading partners:

1. In the Setup and Maintenance work area, go to the **Manage B2B Configuration** task in the Manufacturing and Supply Chain Materials Management offering.
2. In Oracle B2B, click the **Add New Trading Partner** icon.
   
   Ensure that partner name you enter is the same as the trading partner or service provider name set up for your partner in Collaboration Messaging Framework.
3. Click **OK**, confirm, and then click **Save**.
   
   You also need to create a generic identifier for the trading partner that is the same as either the Service Provider Name or the Trading Partner Name in Collaboration Messaging Framework (and pass that value in the FROM of the HTTP header to identify the trading partner).

### Set Up Documents to be Exchanged Through Oracle B2B

After setting up a trading partner and delivery channel, here’s how you can set up documents to be exchanged in messages:

1. In Oracle B2B, on the Documents tab, click the Add Document Definition icon.
2. Select the required document definition and click Add.
Chapter 13
Manage B2B Configuration

Note:
- The documents prefixed with CMK_ are predefined Collaboration Messaging Framework messages (except for OAG 7.2.1, which is displayed as OAG).
- The first level of selection in the dialog box is the document protocol, which correlates to the message standard in Collaboration Messaging Framework. The next level is the protocol version that correlates to the version standard in Collaboration Messaging Framework. The third level is the document type that correlates to the message type of the external message definition in Collaboration Messaging Framework.
- After you select the document for the partner, you can define whether it’s inbound or outbound using the Sender (message is outbound) and Receiver (message is inbound) check boxes.

If you have a user-defined external message definition:
- You need to add a document definition in Oracle B2B ensuring that the message type is the same as the B2B document type (Administration > Document > Routing). For inbound documents, you need to set the Document Routing ID to CMK_OSN_INBOUND (this is the Collaboration Messaging Receiving Composite ID).

3. Click Save.

Setup a Delivery Channel for the Trading Partner
You need to set up channels for outbound message exchange.

1. In Oracle B2B, on the Channels tab, click the Add Channel to Trading Partner icon.
2. Select Generic HTTP from the Protocol drop-down list.
   In the Channel Details section, Transport Protocol Parameters tab, enter a URL as an endpoint, user name, and password, and select the Use Proxy check box.
3. Click Save.

Set Up Trading Partner Agreements
In Oracle B2B, when you want to exchange messages with a trading partner, you need to create a trading partner agreement for all documents that are exchanged.

1. In Oracle B2B, in the Agreement Section click the Create New Agreement icon.
2. Fill in the relevant details and click Save.

For more information see the Oracle Cloud User's Guide for Oracle B2B.

Related Topics
- Overview of Managing External Message Definitions
- Create an External Message Definition
- Add a Message Standard Lookup Code

Header Information for Exchanging Messages
Header Information for Outbound Messages to Service Providers

For outbound messages, Collaboration Message Framework passes these additional header fields to Oracle B2B:

- SENDER_ID: Value of the Global Sender ID in Collaboration Messaging Framework
- SENDER_ID_TYPE: Value of the Global Sender ID Type in Collaboration Messaging Framework
- RECIPIENT_ID: ID of the trading partner set up in Collaboration Messaging Framework to whom the message is to be delivered
- RECIPIENT_ID_TYPE: ID Type of the trading partner set up in Collaboration Messaging Framework to whom the message is to be delivered

If you need to have user name and password authentication, set it up in Oracle B2B as part of the delivery channel setup. You can also set up any other header fields that a service provider requires.

For more information see the Oracle Cloud User's Guide for Oracle B2B.

Related Topics
- Overview of Managing External Message Definitions
- Create an External Message Definition
- Add a Message Standard Lookup Code

Header Information for Inbound Messages from Service Providers

Oracle B2B identifies a service provider using the From HTTP Header field. Ensure that the value you specify is the generic identifier of the B2B trading partner that represents the service provider that's set up in Collaboration Messaging Framework.

Any inbound message from a service provider may include the following additional header fields to identify the Collaboration Messaging Framework trading partner:

- SENDER_ID: ID of the trading partner as set up in Collaboration Message Framework
- SENDER_ID_TYPE: ID Type of the trading Partner as set up in Collaboration Message Framework

Collaboration Message Framework retrieves document-related information from the trading partner agreement.

If you don't specify the HTTP headers SENDER_ID and SENDER_ID_TYPE, you may include the Trading Partner ID and Trading Partner ID Type in the payload as indicated by the Trading Partner ID and Trading Partner ID Type XPath in the external message definition associated with the message definition for the specific message.

For more information see the Oracle Cloud User's Guide for Oracle B2B.

Related Topics
- Overview of Managing External Message Definitions
- Create an External Message Definition
- Add a Message Standard Lookup Code
Outbound Messages to Trading Partner with No Service Provider

In case of trading partner messaging (when no service provider is involved), there is no need to identify a recipient because the trading partner is the recipient. In such cases, the framework doesn't include additional protocol header fields. You can configure any fields needed by the trading partner on the channel definition in Oracle B2B.

For more information see the Oracle Cloud User's Guide for Oracle B2B.

Inbound Messages from Trading Partner with No Service Provider

Oracle B2B identifies the trading partner using the **From HTTP** header field. The value that you specify must be the generic identifier of the trading partner.

For more information see the Oracle Cloud User's Guide for Oracle B2B.
14 Set Up B2B Digital Certificates

Overview of Setting Up B2B Digital Certificates

To improve security and reliability, you can exchange B2B messages using the AS2 protocol via Oracle B2B. The AS2 protocol uses digital certificates to establish keys for the encryption and decryption of B2B messages exchanged with your trading partners. In the Collaboration Messaging Work area, you can use the Manage B2B Certificates task to set up digital certificates. This chapter breaks down the details for setting that up.

Create Keystore Password

The keystore is a repository of security certificates used for a number of security purposes, such as encryption and authentication. Before generating or importing certificates, you must enter a keystore password.

Take these steps:

1. In the Collaboration Messaging work area, click Manage B2B Certificates in the Tasks panel.
3. Enter a new keystore password.
4. Click Save and Close.

Generate Certificate

On the Manage B2B Certificates page, you can generate a digital certificate, which includes a self-signed key pair (of public and private keys).

Take these steps:

1. In the Collaboration Messaging work area, click Manage B2B Certificates in the Tasks panel.
3. On the Generate page, enter an alias, private key password, and common name for your X.509 certificate. These fields are required; the other fields are optional.
### Table: B2B Digital Certificate Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>A unique string to identify the key entry.</td>
</tr>
<tr>
<td>Private Key Password</td>
<td>A user-created phrase to verify identity when generating certificate signing requests, importing, or deleting private keys.</td>
</tr>
<tr>
<td>Common Name</td>
<td>An element of the distinguished name (DE) for the certificate. The common name that identifies the entity for which the certificate is created, when communicating with other web entities. The common name must match the name of the entity presenting the certificate. The maximum length is 64 characters.</td>
</tr>
<tr>
<td>Organization</td>
<td>Optionally identifying value for the organization.</td>
</tr>
<tr>
<td>Signature Algorithm</td>
<td>An algorithm by which keys are generated. A secure hashing algorithm is a cryptographic hash function designed by the United States National Security Agency. Your choices are:</td>
</tr>
<tr>
<td></td>
<td>- SHA256WITHRSA - SHA256 produces a 256-bit (32-byte) hash value, typically rendered as a 64-digit hexadecimal number. The hash value is then encrypted with a private key using the Rivest-Shamir-Adleman (RSA) algorithm.</td>
</tr>
<tr>
<td></td>
<td>- SHA384WITHRSA - SHA384 produces a 384-bit (48-byte) hash value, typically rendered as a 96-digit hexadecimal number. The hash value is then encrypted with a private key using the RSA algorithm.</td>
</tr>
<tr>
<td></td>
<td>- SHA512WITHRSA - SHA512 produces a 512-bit (64-byte) hash value, typically rendered as a 128-digit hexadecimal number. The hash value is then encrypted with a private key using the RSA algorithm.</td>
</tr>
<tr>
<td>Key Length</td>
<td>Key length in bits (2048, 1024, or 768) used by the signature algorithm.</td>
</tr>
<tr>
<td>Valid</td>
<td>A validity period, in days. You can enter a new value to override the default value of 365 days.</td>
</tr>
</tbody>
</table>

4. Click **Save and Close**. A self-signed private key is added. You will see it on the Manage B2B Certificates page.

### Generate Certificate Signing Request

You need to generate a certificate signing request to send to the certificate authority (CA). When you initiate the request, a file is generated with your private key information. You send that private key information (a file) to the CA, who certifies that the private key came from you. Then the CA stamps their approval with a seal, and returns a certificate file to you. You have to import that file from the CA to complete the process.

Take these steps:

1. On the Manage B2B Certificates page, locate the self-signed private key for which you want to generate a certificate signing request. You can narrow the list of certificates by using the Search field to enter whole or partial words or click **Refine** to choose from predefined values.

2. Select **Generate Certificate Signing Request** from the drop-down list in the Action column.
3. Enter the private key password and click **Save As**. The password you enter should match the password you defined when you generated the certificate.
4. Select **Save File** and click **OK**.
5. Choose a location and file name for the certificate file; then click Save. The default file name is `<alias>.cer`.
6. Forward the certificate file to your CA. Follow the process established by your organization.

### Import Signed Certificate from CA

After you have received a response to the certificate signing request from the certificate authority (CA), you will import the signed key. When you import the key, it replaces the self-signed private key certificate with a trusted one (signed by the CA).

Take these steps:

1. On the Manage B2B Certificates page, locate the self-signed private key for which you want to import the key signed by the CA. You can narrow the list of certificates by using the Search field to enter whole or partial words or click **Refine** to choose from predefined values.
2. Select **Import** from the drop-down list in the Action column.
3. Enter the password of the self-signed private key certificate.
4. Browse for the file you want to upload, select it, and click **Import**. The file that contains the key signed by the certificate authority is uploaded. Notice that the Type field changed from Self-Signed to Trusted.

### Export Certificate

Take these steps:

1. On the Manage B2B Certificates page, locate the certificate you want to export. You can narrow the list of certificates by using the Search field to enter whole or partial words or click **Refine** to choose from predefined values.
2. Select **Export** from the drop-down list in the Action column.
3. Select **Save File** and click **OK**.
4. Choose a location and file name for the certificates file; then click **Save**. The default file name is `<alias>.cer`.

### Delete Certificate

Take these steps:

1. On the Manage B2B Certificates page, locate the certificate you want to delete. You can narrow the list of certificates by using the Search field to enter whole or partial words or click **Refine** to choose from predefined values.
2. Select **Delete** from the drop-down list in the Action column. A warning message appears.
3. Enter the private key password and click **Yes**. Or just click Yes if the key is **public**; no password is required to delete a public key.
Import Certificate

You can import a certificate (.cer) file or you can import a keystore that contains one or more certificates.

Take these steps:

1. In the Collaboration Messaging work area, click Manage B2B Certificates in the Tasks panel.
2. On the Manage B2B Certificates page, click Import.
3. Choose whether you’re importing a certificate or a keystore.
4. Enter identifying values, which depend on what you have chosen to import. In both cases, you will need to enter an alias. If you selected Keystore, you will also need to provide a keystore password and private key password.

   **Note:** If you’re importing a certificate (.cer) file, the alias you enter doesn’t need to match the alias used for the .cer file. It can be different.

5. Browse for and select the file you want to import; then click Open.
6. Click Import and Close. The Manage B2B Certificates page displays a record for the imported certificate, and the Private Key column is deselected (absent a check mark).

Complete the Setup of B2B Digital Certificates

You need to use Oracle B2B to complete the setup required to exchange messages with your trading partners using the AS2 protocol. In Oracle B2B, you set a keystore password that matches the one you entered in Collaboration Messaging Framework. Then define an AS2 identifier for your company, your trading partners, and outbound agreements.

For more information see:

- The Manage B2B Configuration chapter of this guide.
15 Domain-Value Maps

Overview of Domain-Value Mapping

When you exchange messages with trading partners, your values for specific data elements in Oracle applications may differ from the values of your trading partners for the same data elements. For example, your trading partner may use “Massachusetts” whereas you use the abbreviated term MA for the name of the state. You can map such data elements using the Manage Collaboration Messaging Domain Value Map task from the Setup and Maintenance work area. A domain-value map associates values used by one domain for a specific field to the values used by other domains for the same field.

How You Set Up and Use Domain-Value Maps

Here is the high-level process for setting up and using domain-value maps. Each step is then described in detail.

1. Review domain-value map names incorporated into predefined message definitions.
2. Set up domain values, entering the values that you use and the values that your customers or suppliers use.
3. Specify the Trading Partner Qualifier to be used for looking up domain-value maps for your customers or suppliers.

Review Domain-Value Map Names in Predefined Messages

Some predefined message definitions are set up in Collaboration Messaging Framework incorporating domain-value map names to allow for mapping your Oracle applications values to your trading partners’ values. If you want to use that mapping, you have to set up the same domain-value map names in Setup and Maintenance, using the Manage Collaboration Messaging Domain Value Map task.

You can see which domain-value map names are used in a particular predefined message definition for a service provider or a trading partner that doesn’t use a service provider.

View Domain-Value Map Names in a Predefined Message Definition for a Service Provider

Here’s how you can see which domain-value map names are used in a particular predefined message definition for a service provider:

1. Go to the Collaboration Messaging Framework work area and click Manage Collaboration Messaging Service Providers from the Tasks pane.
2. On the Manage Collaboration Messaging Service Providers page, search for a service provider.
3. Select the service provider and click Actions > Edit.
4. On the Edit Collaboration Messaging Service Provider page, click Inbound Collaboration Messages or Outbound Collaboration Messages, as required.
5. Select a message and click **Actions > View Domain Value Maps**. A dialog box displays the domain-value map names.

**View Domain-Value Map Names in a Predefined Message Definition for a Trading Partner**

Here's how you can see which domain-value map names are used in a particular predefined message definition for a trading partner that doesn't use a service provider:

1. Go to the Collaboration Messaging Framework work area and click **Manage B2B Trading Partners** from the Tasks pane.
2. On the Manage B2B Trading Partners page, select **None** as the **Service Provider**. Then click **Search**.
3. Select your service provider and click **Actions > Edit**.
4. On the Edit Trading Partner page, click **Inbound Collaboration Messages** or **Outbound Collaboration Messages**, as required.
5. Select a message and click **Actions > View Domain Value Maps**. A dialog box displays the domain-value map names.

You can also identify the DVM names in use in a message by looking for the `dvm:lookupValue` call and finding the **DVM Name** in the XSL files associated with the message definition for that message.

**Set Up Domain-Values Maps**

Here's how you set up domain-value maps:

1. In the Setup and Maintenance work area, go to the Manage Collaboration Messaging Domain Value Map task:
   - Offering: Manufacturing and Supply Chain Materials Management
   - Functional Area: Customers or Suppliers
2. On the SOA Composer page, click **Open > Open DVM**.
3. In the Select a DVM to open window, select **Shared DVMs or All** from the **Show** drop-down list.
4. Select **FusionCode.dvm** and click **Open**.
   A table appears with these columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVM Name</td>
<td>Name of the domain being mapped, for example, CURRENCY_CODE, STATE.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The domain-value map name is used to identify the domain in the XSL file when mapping values.</td>
</tr>
<tr>
<td>Oracle Fusion Value</td>
<td>Value of this domain in the Oracle application.</td>
</tr>
<tr>
<td>Trading Partner Qualifier</td>
<td>Identifies the domain-value map setup for a trading partner.</td>
</tr>
</tbody>
</table>
Add or Edit Domain-Value Map Data

Here’s how you add new domain-value map data or edit existing ones:

1. In the Setup and Maintenance work area, go to the Manage Collaboration Messaging Domain Value Map task. After you select FusionCode.dvm and click Open, do one of these:
   - To add a new domain-value map, click the plus icon.
   - To edit an existing domain-value map, select it, and click the pencil icon.
2. In the window that opens, enter the DVM Name, Oracle Fusion Value, Trading Partner, and Trading Partner Value fields and click OK.
3. On the SOA Composer page, click Save. After saving the changes, click Commit.

Your changes are committed at runtime.

Note: You can map the same domain-value map to different partners with their specific values.

Specify Trading Partner Qualifier for Domain-Value Map Look Up

You can set up the trading partner qualifier used for domain-value map lookup for a supplier or a customer.

Suppliers

You can specify the trading partner qualifier for your suppliers from the Collaboration Messaging Framework work area or from the Procurement work area.

Specify the Trading Partner Qualifier from Collaboration Messaging Framework

1. In the Collaboration Messaging Framework work area, click Manage Supplier B2B Configuration from the Tasks panel.
2. Search for and select a supplier, and click Edit Supplier B2B Collaboration.

You can search by supplier name, supplier number, or optionally, by the supplier’s D-U-N-S number. In the search results, if the Collaboration Configured field is enabled, it means that the sites for the supplier have documents set up.
3. In the Supplier Site Trading Partner Assignment section of the Trading Partner Assignment tab, click Actions > Add Row.
4. Select the Site and Trading Partner ID, and set Domain Value Map to be the same as the Trading Partner Qualifier used in setting up the domain values for the trading partner.
5. Click **Save and Close**.

**Specify the Trading Partner Qualifier from Procurement**

1. From the Procurement work area, click **Suppliers**.
2. Search for and select a supplier.
3. On the Manage Suppliers page, select your supplier and click **Actions > Edit**.
4. On the Edit Supplier page, Sites tab, select a site and click **Actions > Edit**.
5. On the Edit Site page, General tab, Associated Collaboration Documents section, click **Edit**.
6. In the Supplier B2B Configuration dialog box, on the Trading Partner Assignment tab, click **Actions > Add Row**.
7. Select the Site and Trading Partner ID, and set **Domain Value Map** to be the same as the Trading Partner Qualifier used in setting up the domain values for the trading partner.
8. Click **Save and Close**.

**Customers**

You can specify the trading partner qualifier for your customers using either of these tasks from the Collaboration Messaging Framework work area:

- Manage Customer Collaboration Configuration
- Manage Customer Account Collaboration

**Specify the Trading Partner Qualifier Using Manage Customer Collaboration Configuration**

1. In the Collaboration Messaging work area, click **Manage Customer Collaboration Configuration** from the Tasks panel.
2. Search for and select a customer, and click **Edit Collaboration Configuration**.
3. In the Associated Service Providers table, click **Actions > Add Row**.
4. Set **Domain Value Map** to be the same as the Trading Partner Qualifier used in setting up the domain values for the trading partner.
5. Click **Save and Close**.

**Specify the Trading Partner Qualifier Using Manage Customer Account Collaboration**

1. In the Collaboration Messaging work area, click **Manage Customer Account Collaboration Configuration** from the Tasks panel.
2. Search for and select a customer account, and click **Edit Collaboration Configuration**.
3. In the Associated Service Providers table, click **Actions > Add Row**.
4. Set Domain Value Map to be the same as the Trading Partner Qualifier used in setting up the domain values for the trading partner.
5. Click **Save and Close**.
Overview of Importing Collaboration Messaging Setup Data

You can import Collaboration Messaging Framework setup data or you can migrate your Oracle B2B setup data into Collaboration Messaging Framework for trading partners that use a service provider. The service provider, with delivery method, and inbound and outbound collaboration messages, must already be set up in the environment into which you import the data.

If you want to import your Collaboration Messaging Framework setup data, you need to create a ZIP file that contains two CSV files with these names:

- CmkConfigImportPartners.csv: This file contains information about trading partners.
- CmkConfigImportDocs.csv: This file contains the documents that are set up for the trading partner.

You need to upload both the files to the `scm$/B2BConfigurationImport$/import$` account and then follow the procedure in the Import Collaboration Messaging Setup Data section.

You can migrate your Oracle B2B setup data and update Oracle Fusion application setup in these scenarios:

- Data of Oracle Supplier Network Trading Partners
- Data of non-Oracle Supplier Network Trading Partners (a single trading partner, set up with many B2B Supplier site codes)
- Data of non-Oracle Supplier Network Trading Partners (many trading partners, each with a single B2B Supplier site code)

To migrate the data you have to first export your B2B configuration data using the B2B export feature, which creates a compressed file that contains all the B2B setup data, and upload the file into the `scm$/B2BConfigurationImport$/import$` account.

Then you need to use two scheduled processes to create a collaboration messaging setup data import file and then import the collaboration messaging setup data. And then you need to review the imported data using the Manage Collaboration Messaging Setup Data Import task.

Create a Collaboration Messaging Setup Data File

After you export your B2B setup data from B2B and upload it to the `scm$/B2BConfigurationImport$/import$` account, run the Create Collaboration Messaging Setup Data File process.

1. Go to Tools > Scheduled Processes.
2. Click Actions > Schedule New Process.
3. Search for Create Collaboration Messaging Setup Data File and click OK.
4. Specify these parameters:

- **B2B Configuration ZIP file**: The file that you uploaded to the `scm$/B2BConfigurationImport$/import$` account
- **Import Type**: Oracle Supplier Network B2B Setup or Other B2B Setup

<table>
<thead>
<tr>
<th>Import Type</th>
<th>Import Data Extracted</th>
</tr>
</thead>
</table>
| Oracle Supplier Network B2B Setup | 0. Trading partners that have the Oracle Supplier Network Test or Production URL set up with an HTTP Delivery Channel.  
0. Trading partners with a single ID, with ID Type of B2B Supplier Site Code.  
0. Trading Partner Agreements for trading partners that use one of the pre-seeded (V1 implementation) OAG 7.2.1 document definitions. |
| Other B2B Setup             | 0. Trading partners that have an HTTP Delivery Channel with a non-Oracle Supplier Network Test or Production URL.  
0. Trading partner with a single ID or multiple IDs with ID Type of B2B Supplier Site Code.  
0. Trading Partner Agreements for trading partners that use one of the pre-seeded (V1 implementation) OAG 7.2.1 document definitions. |

5. Click **Submit**.

The scheduled process extracts the setup data and creates two the CSV files into the `scm$/B2BConfigurationImport$/import$` account (which is the same account to which you uploaded the B2B export file). The `CmkConfigImportPartners.csv` file contains all the trading partner information that's extracted from the B2B export file and the `CmkConfigImportDocs.csv` file contains all the documents that are set up for that trading partner. The output is a ZIP file that contains these two CSV files.

The records of the `CmkConfigImportPartners.csv` file are described in this table:

<table>
<thead>
<tr>
<th>Column Title</th>
<th>Description</th>
<th>Required During Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImportPartnerId</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ImportBatchId</td>
<td>A unique batch ID.</td>
<td>Y</td>
</tr>
<tr>
<td>ImportPartnerLineNum</td>
<td>A unique line number.</td>
<td>Y</td>
</tr>
<tr>
<td>ImportType</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>PartnerId</td>
<td>Trading Partner ID. For B2B export, this is the trading partner name set up in B2B.</td>
<td>Y</td>
</tr>
<tr>
<td>IdType</td>
<td>ID Type. For B2B export, the ID Type is Name.</td>
<td>Y</td>
</tr>
<tr>
<td>OsnPartnerId</td>
<td>This is the RECEIVER_ID set up in the HTTP channel for Oracle Supplier Network</td>
<td>Optional</td>
</tr>
<tr>
<td>Column Title</td>
<td>Description</td>
<td>Required During Import</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>trading partners. If a value is found, it's used as the Trading Partner ID (this value overrides the Trading Partner ID value). Required only for Oracle Supplier Network migration if partnerkeytype is B2B Supplier Site Code.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OsnPartnerIdType</td>
<td>This is the RECEIVER_ID_TYPE set up in the HTTP channel for Oracle Supplier Network trading partners. If a value is found, it's used as the Trading Partner ID Type (this value overrides the Trading Partner ID Type value).</td>
<td>Optional</td>
</tr>
<tr>
<td>ServiceProviderName</td>
<td>The service provider name to be associated with the trading partner. This service provider must exist in Collaboration Messaging Framework.</td>
<td>Y</td>
</tr>
<tr>
<td>processedStatus</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ExtPartnerStatus</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ExtPartnerFailReason</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>PartnerKeyType</td>
<td>For importing trading partners to be associated to supplier sites, and for the B2B Migration import, this is to be set as B2B Supplier Site Code. For manual import this may be set to Supplier Site and, in that case, PartnerKey1, PartnerKey2, and PartnerKey3 are all required and need to be populated as outlined.</td>
<td>Y</td>
</tr>
<tr>
<td>PartnerKey1</td>
<td>For importing trading partners to be associated to supplier sites, and for the B2B migration import, this is to be set as the value of the B2B Supplier Site Code as specified in the B2B trading partner setup and the Oracle Fusion supplier site record. For manual import if the PartnerKeyType is set to Supplier Site, this is required and will be set to Supplier Name</td>
<td>Y</td>
</tr>
<tr>
<td>PartnerKey2</td>
<td>For manual import if the PartnerKeyType is set to Supplier Site, this is required and will be set to Supplier Site Name.</td>
<td>N</td>
</tr>
</tbody>
</table>
### Column Title | Description | Required During Import
--- | --- | ---
PartnerKey3 | For manual import if the PartnerKeyType is set to Supplier Site, this is required and will be set to Procurement Business Unit Name. | N
partnerKey4 | Not used during import. | N
PartnerKey5 | Not used during import. | N
PartnerKey6 | Not used during import. | N
AppPartnerStatus | Not used during import. | N
AppPartnerFailReason | Not used during import. | N
ApplPartnerId | Not used during import. | N
ExternalPartnerId | Not used during import. | N
importDateTime | Not used during import. | N
CreatedBy | Not used during import. | N
CreationDate | Not used during import. | N
LastUpdatedBy | Not used during import. | N
LastUpdateDate | Not used during import. | N
LastUpdateLogin | Not used during import. | N
ObjectVersionNumber | Not used during import | N

The records of the CmkConfigImportDocs.csv file are described in this table:

### Column Title | Description | Required During Import
--- | --- | ---
ImportDocId | Not used during import. | N
<table>
<thead>
<tr>
<th>Column Title</th>
<th>Description</th>
<th>Required During Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImportPartnerId</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ImportBatchId</td>
<td>Key reference to an import batch.</td>
<td>Y</td>
</tr>
<tr>
<td>ImportPartnerLineNum</td>
<td>Key reference to a trading partner.</td>
<td>Y</td>
</tr>
<tr>
<td>PartnerId</td>
<td>Partner ID.</td>
<td>Y</td>
</tr>
<tr>
<td>IdType</td>
<td>Partner ID Type</td>
<td>Y</td>
</tr>
<tr>
<td>MessagingStandard</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>Version</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>MessageType</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>MessageSubtype</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>DocumentName</td>
<td>A collaboration document name. There must be a message definition set up for the service provider for this collaboration document. The possible list of values depend on what’s set up for the service provider.</td>
<td>Y</td>
</tr>
<tr>
<td>Direction</td>
<td>Direction of the message (In/Out).</td>
<td>Y</td>
</tr>
<tr>
<td>ChannelEndpoint</td>
<td>This isn’t used by the import. It is populated by the Create Collaboration Messaging Setup Data scheduled process if there’s an HTTP channel associated with the trading partner agreement. This is informational only, intended for the user to verify if the documents and trading partners extracted by the scheduled process from the B2B ZIP file are accurate and valid for import.</td>
<td>N</td>
</tr>
<tr>
<td>BusinessProcess</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ImportDelMethodId</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>DeliveryMethodName</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
</tbody>
</table>
### Collaboration Messaging Setup Data Import

<table>
<thead>
<tr>
<th>Column Title</th>
<th>Description</th>
<th>Required During Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExtPartnerDocStatus</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ExtPtnrDocFailReason</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>AppPartnerDocStatus</td>
<td>Possible values are Enabled, Disabled, Hold. This is used to set the status of the application partner document to indicate whether the B2B document for the supplier site is enabled for processing after import. If no value is specified, or the value isn’t one of the listed values, it’s set to Enabled.</td>
<td>Optional</td>
</tr>
<tr>
<td>AppPtnrDocFailReason</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ApplPartnerDocId</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ExternalPtnrDocId</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>PartnerMessageId</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>CreatedBy</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>CreationDate</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>LastUpdatedBy</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>LastUpdateDate</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>LastUpdateLogin</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
<tr>
<td>ObjectVersionNumber</td>
<td>Not used during import.</td>
<td>N</td>
</tr>
</tbody>
</table>

### Import Collaboration Messaging Setup Data

After you create the import file you need to import it using the Import Collaboration Messaging Setup Data scheduled process.

1. Go to **Tools > Scheduled Processes**.
2. Click **Actions > Schedule New Process**.
3. Search for Import Collaboration Messaging Setup Data and click OK.
4. Select Import Type as Import to CMK.

<table>
<thead>
<tr>
<th>Import Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import to CMK</td>
<td>Uploads the setup data to the staging table, validates the import, and creates the valid records in Collaboration Messaging Framework setup tables.</td>
</tr>
<tr>
<td>Validate Only</td>
<td>Uploads the setup data to the staging table and validates the import. No further processing is done.</td>
</tr>
</tbody>
</table>

5. Select the CSV Configuration ZIP File, which you created using the Create Collaboration Messaging Setup Data File scheduled process, or the ZIP file that you created and uploaded.
6. For Oracle Supplier Network data import, enter User Name and Password for the Oracle Supplier Network buyer account.
7. Click Submit.

The records created by the process have a Batch ID stamped on them.

**Manage Collaboration Messaging Setup Data Import**

After you import your collaboration messaging setup data, you can review the imported data.

1. Go to the Collaboration Messaging Framework work area and click Manage Collaboration Messaging Setup Data Import from the Tasks pane.
2. Search for the imported data. You can:
   - Select a row in the Trading Partners section and click Actions > Export to Excel.
   - Select a row in the Documents section and click View > About This Record.

The search results include:

- Reasons for any import failure
- Status of the import of trading partners: Success, Invalid, or Skipped
- Reason for any failure of associating the supplier ID with the trading partner
- Status of association of the supplier with the trading partner: Success, Error, or Invalid
3. Click Done.

**Undo Import**

After reviewing the data, you might sometimes need to undo the import of the setup data that you created using the Create Collaboration Messaging Setup Data scheduled process, for example, if duplicate application partner records are created, you can delete them. Here's what you can do:

1. In the Collaboration Messaging Framework work area, click Manage Collaboration Messaging Setup Data Import in the Tasks panel.
2. In the Trading Partners section, click Actions > Undo Import.
3. Select the Batch ID and click OK.

If multiple batches are imported, you can delete the setup data created by each batch. Delete the latest batch that was imported, followed by the previous one, and so on.
17 Validate Collaboration Messaging Setup

Validate Outbound Collaboration Messaging Setup

After you set up B2B messaging in Collaboration Messaging Framework, you can validate the setup. Let's see how you can do that for outbound collaboration messages.

1. In the Collaboration Messaging Framework work area, click the Validate Outbound Collaboration Messaging Setup task.

Here is the explanation of the fields that appear on that page:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collaboration Business Process</td>
<td>The business process for which you want to validate your setup. The options are:</td>
</tr>
<tr>
<td></td>
<td>o Order To Cash</td>
</tr>
<tr>
<td></td>
<td>o Procure To Pay</td>
</tr>
<tr>
<td></td>
<td>o Supply Chain Operations</td>
</tr>
<tr>
<td>Document</td>
<td>The outbound document for the business process you select.</td>
</tr>
<tr>
<td>Event Name</td>
<td>Automatically populates the name of the business event that initiates messaging.</td>
</tr>
</tbody>
</table>

3. Click Next to select the recipient of the outbound message.
4. On the Validate Outbound Collaboration Messaging Setup: Select Recipient page, select a supplier or customer, depending on the document you selected.

Information about the trading partner is displayed.
5. Click Next.

A sample XML file associated with the message definition for the selected document is displayed. The header section of this XML includes the trading partner and service provider information.
7. Click Process.

The outbound message is processed and validated.

Note: If you set the status of the message to Loopback when you set up the outbound and inbound collaboration messages for the trading partner or service provider, the message is processed but not sent out to the partner.
8. Click **OK** in the Information box to view the details on the Collaboration Message page, which displays these tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Information Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Information about the outbound message, service provider, trading partner, application partner, and message-processing result.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Information about the configuration of the document you selected, its transformation, and message retention duration.</td>
</tr>
<tr>
<td>Delivery Methods</td>
<td>Information about the delivery methods you set up for the partner or service provider.</td>
</tr>
<tr>
<td>Original Message</td>
<td>The message is the payload before it was processed.</td>
</tr>
<tr>
<td>Transformed Message</td>
<td>The message is the payload after it was processed.</td>
</tr>
</tbody>
</table>

**Note:** If there is an error in processing the message, the transformed message isn’t shown.

---

**Validate Inbound Collaboration Messaging Setup**

After you set up B2B messaging in Collaboration Messaging Framework, you need to validate the setup. Let’s see how you can do that for Inbound Collaboration Messages.

1. In the Collaboration Messaging Framework work area, click the **Validate Inbound Collaboration Messaging Setup** task.
2. On the Validate Inbound Collaboration Messaging Setup: Select Sender page, select the sender of the message that you want to validate by selecting your **Service Provider** and **From Partner ID** (trading partner), and click **Next**.
3. Select the message that you want to validate the setup for by selecting these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Message Name</td>
<td>This drop-down list displays all the external message definition names that you set up as inbound messages for the service provider, or trading partner if no service provider is used.</td>
</tr>
<tr>
<td>Collaboration Message Definitions</td>
<td>This drop-down list displays all the collaboration message definition names that you can use to transform the external message.</td>
</tr>
<tr>
<td>Processing Service</td>
<td>If your external message standard is OAGIS, select any processing service from the drop-down list as you need. If the standard isn't OAGIS, select CollaborationMessageV2. Process or CollaborationMessageV2. ProcessAsync as you need.</td>
</tr>
</tbody>
</table>
4. Click Next.
   A sample XML payload associated with the message definition is displayed.
6. Click Process.
   The message is processed as if it were being received from a service provider.
7. Click Next.

   The processed results appear on the Collaboration Message screen that contains four sections:
   - **Details**: Displays the details of the business message, trading partner, service provider, and message processing information.
   - **Configuration**: Displays the details about the configuration of the document and its transformation.
   - **Original Message**: The sample XML payload associated with the message definition used for transformation.
   - **Transformed Message**: This shows the message after the XSL transformation has been applied.
18 Collaboration Messaging History

Overview of Manage Collaboration Messaging History

You can use Manage Collaboration Messaging History task to manage your B2B message communications. You can search for your messages and review the details of any particular message such as its status, processing history, including the number of delivery attempts and errors encountered. You can also delete, reprocess, or resubmit messages using this task.

The Manage Collaboration Messaging History page has three sections, Search, Messages, and Processing History.

How You Search for Messaging History

The Search section of the Manage Collaboration Messaging History page helps you search for specific messages based on a number of criteria.

If you select PROCESS PO OUT, CHANGE PO OUT, CANCEL PO OUT, ACKNOWLEDGE PO IN, ACKNOWLEDGE CHANGE PO IN, PROCESS SHIPMENT, or PROCESS INVOICE IN as a Document, the Order field becomes available. You can use a purchase order number to search for purchase order B2B messages sent to suppliers, or invoices and shipment notification B2B messages received from suppliers.

The Publication ID groups outbound messages published to multiple recipients when there are multiple recipients configured for an outbound document, for example, a PO configured to be sent to a supplier and a third-party service provider.

What the Search Results Contain

The Messages section of the Manage Collaboration Messaging History page displays the search results. Some of the data is specific to the document you selected in the search area. For example, Supplier, Supplier Number, and Supplier Site are displayed for purchase orders that you sent out, and customer name and number are displayed for purchase orders that you receive.

The Collaboration Plan field displays a unique key for Forecast messages sent to a supplier.

Click the Message ID for more information about a message:

- **Details** of a message, trading partner, service provider, and message processing information.
- **Configuration** of a document and its transformation.
- For an outbound message, the **Original Message** is the payload received from Oracle applications before it's transformed and sent out. For inbound messages, it's the same as the message received from your trading partner.
- The **Transformed Message** is the message after the XSL file is applied to the original message and the message has been processed.
- The **Number of Attachments** column provides a link to the View Message Attachment Processing Details dialog box, which displays information about the file name and ID of Processed Attachments and Unprocessed Attachments.
Actions You Can Take on Messages

In the Messages section of the Manage Collaboration Messaging History page, you can take these actions:

- **Delete**: You can delete records but not while the duration time period is in effect.
- **Export to Excel**: Export the records in a spreadsheet.
- **View Collaboration Event**: If an outbound message is triggered by an application raising a collaboration event, we attempt to retrieve the message payload using information provided in the event. If retrieval is unsuccessful, then CMK logs an error, and store the event XML payload in the log. This action can be used to see the details of the event in this case.
- **Reprocess**: You can reprocess a message that wasn't successfully sent. The Retry Count for the message delivery increases.
- **Resubmit**: You can resend an outbound message that was successfully sent earlier. A new message ID is generated for the new message.
- **Cancel**: You can select one or more messages that haven't been successfully sent and click **Cancel** so that no action is taken on them.

Message Processing History

Here's what you can review in the **Processing History** section of the Manage Collaboration Messaging History page after selecting a message:

The **Delivery Attempts** tab displays information about each attempt at delivering a message. If an error occurs in delivering a message, it provides information about the error.

The **Confirmations** tab displays information about each confirmation received for a message delivery such as the message ID, the external message ID, and any processing result code received.